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While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist. The recipient of this document is 
solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is 
subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, or translated into another language, without the prior written 
consent of Deltek, Inc. 

This edition published September 2018. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 
Unauthorized reproduction or distribution of the program or any portion thereof could result in 
severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  
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Overview 

The Deltek Touch for Maconomy application is the best way for on-the-go Deltek Maconomy 
users to not only submit and track time, expenses, and mileage, but also approve time, expenses, 
vendor invoices, purchase orders, and even draft client invoices. It gives you access to several 
dialog boxes related to Time Registration and Expenses (both Expense and Mileage) in 
Maconomy. Even when you are away from the office, immediate mobile device access means 
Deltek Touch keeps you informed and in control. 

 

Not all functionality is available in all Maconomy versions and in MScript and REST Web 
services. For more information, see the Deltek Touch for Maconomy Mscript and REST Web 
Services Comparison Guide. 

This document provides instructions for the installation and configuration of the Deltek Touch for 
Maconomy. 

 

The official name of the application is Deltek Touch for Maconomy. This document only uses it 
at first mention. The succeeding instances of the application name display Deltek Touch. 

In addition, the application name in Apple App Store and Google Play displays Deltek Touch for 
Maconomy. 

Supported Mobile Operating Systems 

Deltek Touch for Maconomy supports mobile devices that run on the following operating systems: 

 Apple iOS 9.0 and higher 

 Android 6 and higher 

 

Starting 2.3, Deltek no longer supports Windows Phone. In addition, Deltek Touch Web 
application will no longer run in Internet Explorer, the only supported browsers are Safari and 
Chrome.  

 



 

 

What Is new? 

Touch Installer 

The following updates are made to the Touch 3.0 Installer:  

PHP 

 Touch Installer for Windows will now install PHP 7.2.10, containing several security 
updates compared to the previous PHP version 

IIS  

 For security reasons, the Server value is removed in Headers 

 For security reasons, the Strict-Transport-Security HTTP header is sent with each 
HTTPS response 

 IIS Management Scripts and Tools validation added to the Installer 

 Support for creating dedicated "Touch" IIS site via the Installer. It is no longer a pre-
requisite to create an IIS site for Touch. Instead, you can let the Installer create the IIS 
site for you. 

Configuration.ini 

 Consistent quotation in configuration.ini,by always using double quotes 

 Improved HELPDOCURL: to help you with the online help setup HELPDOCURL contains 
server url, as default value 

 New Boolean setting REQUIREDEVICEPASSCODE 

Additional Functionality 

 .Net 2.0 is no longer required by the Installer 

Azure 

Touch 3.0 (and later) no longer supports the Azure OAuth protocol. 

If you would like to use Azure authentication in Touch 3.0 (or later), you need to have Maconomy 
2.4 LA 2 (or later), set up with the Azure OpenID protocol. 

Touch Backend Software Availability in DSM 

Starting with Touch 3.0, Touch is part of a specific Maconomy release. 

As a result, the Touch backend software (including the Touch Installer and Touch FPU) is 
available only for specific Maconomy releases. 

Touch 3.0 is available in DSM only for Maconomy 2.2.6 and 2.1.8 CU5. All other Maconomy 
versions have Touch 2.3 available in DSM. 

We have no plans to release new Touch backend software for Maconomy X1 and 2.0. 

 

Maconomy X1 and 2.0 are in sustaining support mode. This means that Deltek no longer 
delivers enhancements or hot fixes for these versions. 

With Touch 3.0, Touch no longer comes with an updated backend for Maconomy X1 and 2.0. 
The Touch 3.0 app will continue to work against Maconomy X1 and 2.0. 

From Touch 3.2, expected in April 2019, Deltek will no longer guarantee that the app can run 
against Maconomy X1 or 2.0. 

New Touch backend software will be available in the upcoming Maconomy 2.4.3 and 2.3.4 
releases.  



 

 

Touch App 

A new (3.0) version of our Touch iOS and Android app is now available for download from Apple 
Store, respectively Google Play. 

As with the previous app versions, it is compatible with all Maconomy release versions (including 
previously supported Maconomy versions):  

 Maconomy X1 Service Pack 25 (or higher) 

 Maconomy 2.0 Service Pack 3 (or higher)  

 Maconomy 2.1.1 (or higher)  

 Maconomy 2.2 (or higher) 

 Maconomy 2.3 (or higher) 

 Maconomy 2.4 LA 1 (or higher). 

However, the app will run in fully compatible mode, only if you have Maconomy 2.2.6 or 
2.1.8 CU5. On all other Maconomy versions, the app will run in partially compatible mode. 

  



 

 

Downloading Deltek Products Using Deltek 
Software Manager 

You can use Deltek Software Manager (DSM) to download complete Deltek products, hot fixes, 
and sub-releases. You can access DSM directly or through the Deltek Customer Care Connect 
site. 

When you access DSM directly, you will be prompted to log on before you can access the 
application. If you access DSM from within the Deltek Customer Care site, you do not have to log 
on since you are already logged into the Customer Care site. 

Accessing DSM Directly 

To access Deltek Software Manager directly, complete the following steps: 

1. Launch Deltek Software Manager by taking one of the following actions: 

 Click 3TUhereU3T.  

 On your desktop, click Start » All Programs » Deltek Software Manager. 

2. In the Deltek Software Manager logon dialog box, enter your Deltek Customer Care User 
ID and Password, and click Logon. 

3. To select the folder where you want to download Deltek products, click Settings above 
the right pane of Deltek Software Manager. 

 

When you log on for the first time, Deltek Software Manager asks you to select a 
default folder where Deltek products are to be downloaded.  

4. Use the Settings dialog box to specify the folder where you want to download Deltek 
products, and click OK.  

 

You can change this folder anytime in the Settings dialog box.  

5. In the left pane of Deltek Software Manager, expand the Deltek product that you want to 
download, if it is not already expanded.  

 

If you clicked the link in step 1 to access DSM, the application automatically selects 
Deltek Touch for Maconomy for you. 

6. Select the product type that you want to download. Your options are Complete, HotFix, 
and Sub-Release. 

7. In the table, select the check box that corresponds to the Deltek product that you want to 
download. The right pane displays a message stating that the product has been added to 
the download queue. 

 

To view the items in the download queue, click View Download Queue at the bottom 

of the left pane.  

8. Click Download at the bottom of the left pane. Deltek Software Manager downloads the 
product to the folder that you selected.  

https://dsm.deltek.com/DeltekSoftwareManager/DeltekSoftwareManager.application?ReleaseID=A6382C0B-0649-42E6-A41D-2E5687FE6F8F


 

 

Accessing DSM from within the Customer Care Connect Site 

To access Deltek Software Manager from within the Customer Care Connect site, complete 
the following steps: 

1. In your Web browser, go to 3TUhttp://support.deltek.com U3T.  

2. Enter your Customer Care Connect Username and Password, and click Log In. 

3. When the Customer Care Connect site displays, click the Product Downloads tab. 

You are automatically logged into Deltek Software Manager. 

4. To select the folder where you want to download Deltek products, click Settings above 
the right pane of Deltek Software Manager. 

 

When you log on for the first time, Deltek Software Manager asks you to select a 
default folder where Deltek products are to be downloaded.  

5. Use the Settings dialog box to specify the folder where you want to download Deltek 
products, and click OK.  

 

You can change this folder anytime in the Settings dialog box.  

6. In the left pane of Deltek Software Manager, expand the Deltek product that you want to 
download, if it is not already expanded.  

7. Select the product type that you want to download. Your options are Complete, HotFix, 
and Sub-Release. 

8. In the table, select the check box that corresponds to the Deltek product that you want to 
download. The right pane displays a message stating that the product has been added to 
the download queue. 

 

To view the items in the download queue, click View Download Queue at the bottom 

of the left pane.  

9. Click Download at the bottom of the left pane. Deltek Software Manager downloads the 
product to the folder that you selected.  

  

http://support.deltek.com/


 

 

DSM Documentation and Troubleshooting 

 To view the online help for Deltek Software Manager, click 3TUhereU3T. 

 To view a tutorial on how to use Deltek Software Manager, click 3TUhereU3T.  

 To view more information on troubleshooting Deltek Software Manager, click 3TUhereU3T. 

 

The above troubleshooting link will only work if you are logged into Deltek Customer 
Care Connect. 

https://dsm.deltek.com/DeltekSoftwareManager/Help/
https://dsm.deltek.com/DeltekSoftwareManager/Tutorial/PubData/Engine/Default.htm?https%3A%2F%2Fdsm.deltek.com%2FDeltekSoftwareManager%2FTutorial%2FPubData%2F
https://deltek.custhelp.com/app/answers/detail/a_id/52469


 

 

Prerequisites 

Before you begin the installation of Deltek Touch for Maconomy, it is important to understand the 
information in this section. 

Technical Considerations 

The following requirements must be met to run Deltek Touch for Maconomy: 

 Deltek Touch can be run only on Maconomy X1 Service Pack 25 (or higher), 
Maconomy 2.0 Service Pack 3 (or higher), Maconomy 2.1.1 (or higher), Maconomy 2.2 
(or higher), Maconomy 2.3 (or higher), and 2.4 LA 1 (or higher). 

 Deltek Touch cannot be installed on Sun (Solaris) or AIX server platforms. As a 
workaround, it is possible to install Touch Time on Windows or RHEL and then attach it 
to a Maconomy server running on Sun or AIX. 

 Deltek Touch runs on IIS or Apache for Windows and Apache for Red Hat Enterprise 
Linux (RHEL). 

 Environment  Prerequisites 

Windows + IIS  Deltek Touch requires IIS be installed on a server that runs 
Windows Server 2008, Windows Server 2008 R2, Windows 
Server 2012, Windows Server 2012 R2, or Windows Server 
2016. 

 Deltek Touch requires PHP 7.2.10 or higher to be installed 
on IIS. The Touch Server installer installs the required 
version of PHP. 

Windows + Apache  You must install Apache on a server that runs Windows 
Server 2012, Windows Server 2012 R2, or Windows Server 
2016. 

 Deltek Touch requires PHP 7.2.10 or higher to be installed 
on IIS. The Touch server installer installs the required 
version of PHP. 

 For Maconomy 2.1 and later using Apache on Windows, 
you must use Apache 2.4 for both Deltek Touch and 
Maconomy. 

 For Maconomy X1 and 2.0 using Apache on Windows, you 
must have Deltek Touch installed on Apache 2.4 and 
Maconomy on Apache 2.2. 

Linux + Apache  Deltek Touch supports RHEL 5.x (starting with 5.6) and Red 
Hat Enterprise Linux 6.x 

 Deltek Touch only supports Apache 2.2 and Apache 2.4 on 
Linux.  

 On RHEL 5.x, Apache 2.2 is required. 

 On RHEL 6.x, Apache 2.4 is required. 



 

 

 Environment  Prerequisites 

 

All Maconomy versions are certified on Apache 
2.2. However, none of the Maconomy versions 
are currently certified on Apache 2.4 on Linux. 
Therefore, on RHEL 6.x, Deltek recommends 
using different Apache installations for the 
Touch Server (Apache 2.4) and Maconomy 
(Apache 2.2). 

 Deltek Touch requires PHP to be installed: 

 On RHEL 5.x, Deltek Touch requires PHP 5.3.3 or 
later.  

 On RHEL 6.x, Deltek Touch requires PHP 5.6.25 or 
later. 

 Our tests were conducted on the following setups: 

 RHEL  5.6 + PHP 5.3.3 + Apache 2.2.3 

 RHEL  6.0 + PHP 5.6.25 + Apache 2.4 

 RHEL  6.5 + PHP 5.6.25 + Apache 2.4   

 

 Deltek Touch is based on Maconomy dialogs. Therefore, Maconomy must be set up 
correctly with regards to functionality and dialog access. Please see section below for 
futher details. 

 Deltek Touch for Maconomy setup requires the following add-ons:  

 Maconomy Portal: Daily Time Sheets (110)  

 Time on time (122) 

 Deltek Touch for Maconomy supports Single Sign-On (login using domain 
credentials) using Kerberos on both Apache and IIS Web server. 

 Deltek Touch for Maconomy also supports SSO with the Windows Azure Active 
Directory (WAAD). 

 Session cookies must be disabled when using Deltek Touch for Maconomy (in 
MaconomyTouch.I). 

 

In Maconomy 2.0 and later, by default, session cookies are disabled in 
MaconomyTouch.I.  

 Deltek Touch for Maconomy supports applications from Apple App Store and Google 
Play. If you are using an unsupported version of Maconomy (compatibility mode), you 
may be able to use the native browser of your device to enter your organization’s 
Deltek Touch for Maconomy URL. 

 

The Deltek Touch for Maconomy URL has the format 
https://<server>/deltektouch/maconomy/time, where <server> refers to the host name 
of your Touch Server. 

Not Supported 

 Deltek Touch does not support different Touch Server versions on the same machine. 



 

 

 

There is no problem to have Touch test/prod/… on the same web server as long as 
they all have the same Touch Server version. 

 What is not supported is to have on the machine hosting different Touch server 
versions (for example, on the same machine, you cannot have Touch Server 2.1 and a 
Touch Server 2.2). 

PHP is the main reason Deltek Touch does not support multiple Touch Server versions 
on the same machine. Deltek always tries to use the latest PHP version available each 
time the Deltek Touch application is released, especially if the PHP release contains 
security fixes. 

Based on your (consultants) feedback, you do not recommend to upgrade a test and a 
production environment in one go. If that is the case, you need to have separate test 
and prod Web servers for Deltek Touch, so you can upgrade them separately. 

 If you are using RESTful Web service and HTTP/2 is enabled, Deltek Touch would not work. 
This limitation only applies to Deltek Touch if the Touch Server is running on IIS installed on a 
Windows Server 2016. 

Microsoft IIS 10 that comes with Windows Server 2016 has HTTP/2 enabled by default. 
Maconomy is not currently certified for use with HTTP/2; therefore, Deltek recommends 

that you disable HTTP/2 in IIS 10 to avoid any issues. 

 

To disable HTTP/2, complete the following steps: 

1. Start the registry editor (regedit). 

2. Go to the following path: 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\HTTP\Paramet
ers 

3. Under the Parameters folder, add two new DWORD (32-bit) values as follows: 
EnableHttp2Tls and EnableHttp2Cleartext. 

4. Ensure both new values have been set to 0 (disabled). 

5. Restart your machine. 

 

  



 

 

Compatibility Mode Definitions 

Compatibility Mode Description 

Fully Compatible You must be on Touch Android application, iOS application, Web 

application, Touch Server, and AP. All features and functions in the 

application are available to you. 

Partially Compatible At least one of the components (Touch Server and/or API) is an 

older version. Some features of the application are hidden and not 

available to you. 

Browser Compatible This ony applies to system administrators. At least one of the 

components (Touch Server and/or API) is an older version. The 

current application does not work with the Touch Server or API, but 

you can still use the application through the mobile browser. 

If you are using the browser version of Deltek Touch, not all 

functionality will be available and you should expect considerably 

slower performance of loading of the application when accessing 

from browser. 

Incompatible There are some combinations of API and Touch Server that make it 

impossible to even use the browser version to run the application. 

In case of incompatibility, Deltek Touch displays two messages. The 

first one informs you about the incompatibility that it detects. 

Clicking OK on the incompatibility message displays the debug 

message, which contains additional information about the 

environment and is meant only for troubleshooting. After you click 

OK on the debug message, you cannot use the native application 

anymore. 

 

You could also encounter the debug message when using 
the browser version of Deltek Touch, but this is a very rare 
situation. It happens if the network communication fails 
during login because the application is retrieving the Touch 
Server version from the configuration.ini file. If the Touch 

Server version is not retrieved, the incompatible and debug 
messages display. 

The debug message displays when one of the following scenarios 

occur: 

 The minimum Touch Server version defined in Deltek Touch is 
greater than the version in the Deltek Touch Server. For 
example: 

 App Minimum Touch Server Version: 1.0.3.0 

 Deltek Touch Server: 1.0.2.0 

 The maximum Touch Server version defined in Deltek Touch is 
lower than the version set in Deltek Touch Server. For 



 

 

Compatibility Mode Description 

example: 

 App Maximum Touch Server Version: 1.3.1.0 

 Deltek Touch Server: 1.3.2.0 

 If there is no Touch Server version defined on the Deltek Touch 
Server or Deltek Touch cannot retrieve the current Touch 
Server version. 

 If there is no product version retrieved by the client-side. 

 If the product version is not supported by the client-side. 

 If the API version is not supported by the client-side 

  



 

 

Feature Matrix 

Feature Touch Version 3.0 

Maconomy Version X1 2.0 2.1 2.2 2.3 2.4 

Weekly Time Registration ● ● ● ● ● ● 

Daily Time Registration ● ● ● ● ● ● 

Expense Registration  ● ● ● ● ● 

Mileage Registration  ● ● ● ● ● 

Approvals (Expense, Purchase Order, Vendor Invoice, 
Draft Invoice) 

  ● ● ● ● 

Rejected Time Flow   ● ● ● ● 

Approval by Employee Type   ● ● ● ● 

Possibility to Use Remarks on Favorites   ● ● ● ● ● 

Layout Configuration (see Layout Configuration Guide 
for details) 

● ● ● ● ● ● 

Server-Side Configuration Options (see Installation 
Guide for details) 

● ● ● ● ● ● 

Unicode Support   ● ● ● ● 

Support for RESTful Web Services (from 2.2.4 and 2.3 
GA) 

   ● ● ● 

Auto-Completion of Domain Name ● ● ● ● ● ● 

Password Management: Change, Reset, Expired and 
Blocked Password 

      

Expense Justification       

 Support for SSO with Microsoft Azure      ● 

Registering Time in Days       

Approving Time in Days    ● ● ● 

Support for Login to Touch Using Maconomy 
Credentials in an SSO Environment 

● ● ● ● ● ● 

Purchase Order Fields Available in Timesheet and 
Expense Sheet for Subcontractor 

      



 

 

Feature Touch Version 3.0 

Notifications for Rejected Expenses and Mileage       

Purchase Orders       

Absence Management       

Enhanced PIN Security ● ● ● ● ● ● 

Timesheet Tracking Post Submission       

Enhanced Usage Tracking ● ● ● ● ● ● 

Favorites Only on Find Job Screen ● ● ● ● ● ● 

Automatic Receipt Name for Attachment on Expense 
Sheet 

● ● ● ● ● ● 

 Absence in Hours       

Enhanced Look and Feel ● ● ● ● ● ● 

 

 

The  symbol indicates that a feature is available for Touch installations using the RESTful API 

only. The ● symbol indicates that the feature is available for both MScript and REST. 

Standard Maconomy Functionality Not Available in Deltek Touch 

The following Maconomy standard features are not available in Deltek Touch: 

 Long text fields 

 Approval by substitute or super approver 

 Notifications for rejected purchase orders, vendor invoices, and draft invoices 

 Monthly timesheets 

 Proxy time registration 

Maconomy Configuration 

MScript 

If Deltek Touch is using the old (MScript-based) web services, make sure that users have access 
to the following dialogs: 

Time 

 TimeRegistration 

 DailyTimeRegistration 

 DailyTimeSheets 

 DailyTimeSheetLines 



 

 

 JobFavorite 

 JobFavorites 

 TimeSheets 

Expense  

 ExpenseSheets 

 MileageSheets 

 DocumentArchives 

 DocumentRevisions 

Approvals 

 ApprovalObjects 

 ExpenseSheetLines 

 TimeRegistrationDetails 

 PurchaseOrders 

 ShowVendorInvoices 

 InvoiceEditing 

RESTful 

If Deltek Touch is using the new (RESTful) web services, make sure that users have access to 
the following dialogs: 

Login: 

 API_CurrentEmployee 

Time: 

 TimeRegistration 

 DailyTimeRegistration 

 JobFavorite 

 Expense: 

 ExpenseSheets 

 MileageSheets 

 DocumentArchives 

 Notes 

Absence and Allowance: 

 AbsenceCalendarLines 

 AbsenceEntryOverview 

Purchase orders: 

 PurchaseOrders 

 DocumentArchives 

Approvals 



 

 

 ApprovalObjects 

 ExpenseSheetLines 

 TimeRegistrationDetails 

 PurchaseOrders 

 ShowVendorInvoices 

 InvoiceEditing 

Recommended System Parameters  

Use Daily Time Sheets 

If use MScript in weekly or daily mode, or if you use REST in daily mode, make sure that you 
mark the “Use daily time sheets” system parameter during installation to register time on a day at 
a time.  

 

  



 

 

Allow Incomplete Time Registrations 

Another recommended system parameter is “Allow Incomplete Time Registrations.” This system 
parameter is not required, but if you select it, the application allows you to add a line with, for 
example, only a description. This task must be completed before submission. 

A similar system parameter can be enabled for expenses. This supports the workflow for Quick 
Capture. 

 

  



 

 

Deltek Touch for Maconomy Infrastructure 

The Deltek Touch for Maconomy infrastructure is composed of the application tier, middle tier, 
and services tier. The Touch Server (middle tier) is used to optimize service delivery and 
transform data when necessary. The Touch Server only communicates with the product service 
layer and does not have access to the database. 

The Touch Application (client tier) is a hybrid application created using HTML 5 and CSS 3 but 
with the ability to access the native device capabilities. 

Deltek Touch Technology Layers 

 

  



 

 

Services Tier 

For Deltek Touch for Maconomy, the services tier corresponds to the Maconomy Web services. 
The interaction between the Maconomy product and Touch Time (client + middle tier) is 
illustrated below: 

 

Touch 2.0 supports two Web services (MScript and REST) as illustrated below: 

 



 

 

Supported Deployment Scenarios 

The Deltek Touch for Maconomy application may be installed on another IIS or Apache server, or 
as a separate directory on an existing Maconomy IIS or Apache Web server. 

 

 

 

Mobile applications now require HTTP/SSL,using a certificate from a recognized certificate 
authority. Self-signed and SHA-1 encrypted certificates cannot be used. 

Deltek Touch for Maconomy Security 

Deltek Touch for Maconomy is a front-end application that integrates with Deltek’s traditional back 
office applications, such as Maconomy. Deltek Touch only interacts with the Web services layer 
of each of these applications, and no direct database interaction is performed. All data interaction 
is performed in the Web services layer. 

User Authentication Models 

Deltek Touch does not introduce users and passwords, or define its own models. Instead, it uses 
the existing product user provisioning, authentication, and authorization models. 

Deltek Touch does introduce the PIN concept your convenience in application login. Once you log 
in to the system successfully, you can store a PIN to simplify subsequent logins. When the PIN 
feature is used, your credentials are stored on the device in encrypted form. The key to the 
encryption is your PIN. The PIN is not stored on the device, and therefore you must memorize 
it. When the PIN is entered, Deltek Touch tests to see if the credentials are successfully 



 

 

decrypted. If they are, Touch passes the credentials to the backend system for authentication. If 
the credentials do not decrypt after three attempts, the credentials are removed from the device 
storage and you must again enter their full credentials. If you do not use a PIN, you must enter 
your password each time you use the application. 

The encryption is performed by the Stanford JavaScript Crypto Library (SJCL).  SJCL uses 
industry-standard AES algorithm at 128, 192, or 256 bits; the SHA256 hash function; the HMAC 
authentication code; the PBKDF2 password strengthener; and the CCM and OCB authenticated-
encryption modes. 

 

For more information, see 3TUhttp://bitwiseshiftleft.github.io/sjcl/U3T. 

You log in to Deltek Touch using your domain credentials (this requires that both Maconomy and 
Deltek Touch are set up to use Single Sign-On via Kerberos) or using your Maconomy 
credentials. 

Single Sign-On Via Kerberos 

The first time you log in to Touch, you enter your network user name, password, and domain. 
Once successfully authenticated, you must  set a PIN. Once you have set your PIN, you can log 
in using only this PIN. To protect your login credentials in transit, Deltek recommends that the 
Touch Web Server be configured to use HTTPS (instead of HTTP). The domain credentials are 
sent from your mobile device to the Maconomy Web server via the Touch Server. 

Using HTTPS/TLS encrypts your network traffic, making it very difficult to sniff the credentials as 
they are passed to the Web server. On the Maconomy Web server, the domain credentials are 
used only to obtain a Kerberos ticket for the Maconomy service on your behalf. Your domain 
credentials are not stored on the Web server. As soon as this ticket is obtained, the credentials 
are deleted. 

Single Sign-On Via Azure 

The first time you log on to Deltek Touch, you enter your Azure credentials. The Azure user name 
is entered in Deltek Touch, but the password is entered in the native Windows Azure login 
screen. Once successfully authenticated, you must nominate a PIN. Once you have set your PIN, 
you can log on using only this PIN. 

Your Azure credentials are not stored on the Touch Server or the Maconomy server. Instead, the 
token returned by Azure is sent to the Maconomy server to perfrom the Maconomy 
authentication. To protect the Azure token in transit, Deltek recommends that the Touch Web 
Server as well as the REST proxy server be configured to use HTTPS (instead of HTTP).  

Sign on Using Maconomy Credentials 

If Deltek Touch is not set up with Single Sign-On, you log on using your Maconomy credentials 
(user name and password). When logging on the first time using your Maconomy credentials, you 
have the option to set a PIN. Once you have set the PIN, you can use it for future logins. You can 
reset the PIN at any time or you can also switch back to using your Maconomy credentials 
instead of the PIN. 

On the Maconomy Web server, the credentials are used for logging on to the Maconomy system. 
In a successful login, a token is added to the session and the session ID is sent back to your 
mobile device. From that point forward, any communication between the mobile device and 
Maconomy Web server includes the session ID for authentication. This means that the 
Maconomy credentials are sent from the mobile device to the Maconomy Web server only for the 
login. The password is not stored and cannot be reverse-engineered on the Maconomy Web 
server. 

http://bitwiseshiftleft.github.io/sjcl/


 

 

Certificates and Protocols 

For security reasons and due to the SSL restriction that has been enforced by Apple lately, Deltek 
Touch will no longer support HTTP links, which include HTTP for the online help URL (see 
HELPDOCURL in configuration.ini). 

All URLs that Deltek Touch uses must be HTTPS. This includes the Touch Server URL, which 
you enter when you use the application for the first time. It also includes the REST proxy URL. 

 

Deltek recommends that you prepare for this transition beforehand. Otherwise, users will not be 
able to use Deltek Touch application. 

When using Secure Sockets Layer (SSL), you must have a certificate issued by a trusted 
certificate authority. You must not use self-signed certificates or SHA-1 encrypted certificates. 
Wild card certificates work if they come from a trusted certificate authority but are not considered 
a best practice. 

For security reasons, Deltek recommends that you disable HTTP on the Touch Server. To do so, 
remove any configuration for port 80 from the Edit Site Bindings dialog box for IIS and httpd.conf 
(or any relevant .conf file to manage VirtualHosts) on Apache. In addition, make sure Basic 
Authentication is disabled on the Authentication page for IIS and AuthType Basic should be 
commented or not present on the directory directive for Apache. 

Deltek Touch does not allow connections to servers who have either TLS 1.0, SSL 3 (or earlier) 
enabled or any older protocols. Only TLS 1.1 and/or TLS 1.2 may be enabled for connections to 
be successful. 

Users trying to connect to IIS servers running Deltek Touch will get error like “invalid server url” if 
any of the deprecated protocols are enabled. 

To resolve this issue the following must be performed to Touch Server: 

1. Deprecated transport layers disabled – TLS 1.0 , SSL 3 (or earlier). 

2. Supported transport layers enabled (if not already) – TLS 1.1 and/or TLS 1.2. 

3. Restart the server. 

 

Here is a support article from Microsoft on how to disable the deprecated transport layers: 
https://support.microsoft.com/en-us/kb/187498 (How to disable PCT 1.0, SSL 2.0, SSL 3.0, or 
TLS 1.0 in Internet Information Services). 

Security Assessments 

Deltek strives to deliver a highly secure applications. Therefore, an independent security 
assessor, GuidePoint Security, has performed a Mobile Application Security Assessment with the 
intent of evaluating the security posture of Deltek’s Mobile Touch suite of applications. The 
security baselines for the scope of the audit were the OWASP Top 10 Web Application 
vulnerabilities and the OWASP Top 10 Mobile vulnerabilities.  

 

For more information, see 
3TUhttps://www.owasp.org/index.php/Top10#OWASP_Top_10_for_2013 U3T. 

 

https://support.microsoft.com/en-us/kb/187498
https://www.owasp.org/index.php/Top10#OWASP_Top_10_for_2013


 

 

Microsoft IIS Web Server Configuration on 
Windows Server 2008 or Windows Server 2008 R2 

Perform this procedure if you are going to install the Deltek Touch for Maconomy application on 
Windows Server 2008. The Deltek Touch for Maconomy installer checks if Microsoft Internet 
Information Services (IIS) is already installed before proceeding with the installation. The 
installation terminates if IIS is not yet installed. 

To configure Microsoft IIS Web server on Windows Server 2008 or Windows Server 2008 
R2, complete the following steps: 

1. Click Windows » Start » Administrative Tools » Server Manager. 

2. Expand the Roles tree on the left pane, and click Web Server (IIS). 

3. When the Web Server (IIS) screen displays, click Add Role Services in the bottom right 
pane. 

4. On the Select Role Services screen, perform the following actions: 

 Click Web Server » Application Development, and select ISAPI Extensions and 
CGI. 

 Click Web Server » Management Tools, and select IIS Management Scripts and 
Tools. 

 Click Web Server » Management Tools » IIS 6 Management Compatibility, and 
select IIS 6 Metabase Compatibility. 

5. Click Next, and then click Install. 

6. Click Close when the installation completes. 

7. Expand the Web Server (IIS) tree on the left pane, and click Internet Information Services 
(IIS) Manager. 

8. On the Internet Information Services (IIS) Manager screen, expand the IIS computer 
name icon on the left pane of the Internet Information Services (IIS) Manager window.  

9. Right-click the IIS computer name icon, and select Stop. 

10. Right-click the IIS computer name icon on the left pane of the Internet Information 
Services (IIS) Manager window, and select Start. 

11. Close the Services Manager window. 



 

 

Microsoft IIS Web Server Configuration on 
Windows Server 2012  

Perform this procedure if you are going to install the Deltek Touch for Maconomy application on 
Windows Server 2012. The Deltek Touch for Maconomy installer checks if Microsoft Internet 
Information Services (IIS) is already installed before proceeding with the installation. The 
installation terminates if IIS is not yet installed. 

 

Deltek Touch for Maconomy requires Anonymous Authentication and does not support Basic 

Authentication. 

To configure Microsoft IIS Web server on Windows 2012 Server, complete the following 
steps: 

1. From the desktop view, display the Charm Bar. To do this, take one of the following 
actions: 

 Move the cursor to the bottom right corner of the screen, which causes the bar to 
display on the right. 

 On your keyboard, press the Windows key + C. 

 

For more information about Charm Bar, see the following link: 
3TUhttp://windows.about.com/od/windowsforbeginners/a/Get-To-Know-The-New-Windows-
8-Start-Menu.htmU3T. 

2. Click Start » Administrative Tools » Server Manager. 

3. On the left pane, click IIS. 

4. On the right pane, scroll down to the see the ROLES and FEATURES section. 

5. From the Tasks drop-down list, select Add Roles and Features. The Add Roles and 
Feature Wizard displays. 

6. Click Next. 

7. Select the Role-based or feature-based installation option. 

8. On the Select Destination Server page, verify if the Select a server from the server 
pool option is selected. Click Next. 

9. On the Select server roles page, expand Web Server (IIS) » Web Server » Application 
Development, select CGI and ISAPI extensions 

10. On the Select server roles page, expand Web Server (IIS) » Web Server » 
Management Tools, and then select IIS Management Scripts and Tools. 

11. Click on Next. The Select features page displays. 

12. Click Next, and then click Install.  

http://windows.about.com/od/windowsforbeginners/a/Get-To-Know-The-New-Windows-8-Start-Menu.htm
http://windows.about.com/od/windowsforbeginners/a/Get-To-Know-The-New-Windows-8-Start-Menu.htm


 

 

Microsoft IIS Web Server Configuration on 
Windows 2016 Server 

Perform this procedure if you are going to install the Deltek Touch for Maconomy application on 
Windows Server 2016. The Deltek Touch for Maconomy installer checks if Microsoft Internet 
Information Services (IIS) is already installed before proceeding with the installation. The 
installation terminates if IIS is not yet installed. 

 

Deltek Touch for Maconomy requires Anonymous Authentication and does not support Basic 

Authentication. 

To configure Microsoft IIS Web server on Windows 2016 Server, complete the following 
steps: 

1. Click Start » Windows Administrative Tools » Server Manager. 

2. On the left pane, click IIS. 

3. On the right pane, scroll down to the see the ROLES and FEATURES section. 

4. From the Tasks drop-down list, select Add Roles and Features. The Add Roles and 
Feature Wizard displays. 

5. Click Next. 

6. Select the Role-based or feature-based installation option. 

7. On the Select Destination Server page, verify if the Select a server from the server 
pool option is selected. Click Next. 

8. On the Select server roles page, expand Web Server (IIS) » Web Server » Application 
Development, select the CGI and ISAPI extensions 

9. On the Select server roles page, expand Web Server (IIS) » Web Server » 
Management Tools, and then select IIS Management Scripts and Tools. 

10. Click on Next. The Select features page displays. 

11. Click Next, and then click Install.  

 



 

 

Deltek Touch for Maconomy Installation on 
Windows Server 

Before you proceed, make sure that you downloaded the server component from Deltek Software 
Manager (DSM). Once the server part is installed, download the application from Google Play 
Store or Apple App Store and install it in your device.  

 

For more information about DSM, see 3TUDownloading Deltek Products using Deltek Software 
ManagerU3T in this document. 

To install the Deltek Touch application, complete the following steps: 

1. Run DeltekTouchMaconomy30.exe to launch the installation program. 

 

Taking into consideration the enhanced security in Windows Server 2008 and 2012, 
Deltek recommends selecting the Run as Administrator option when launching the 

installation executables even if you (as the logged-on user) has local administrative 
rights. You can access this option by right-clicking the installation executable file name 
in Windows Explorer and then clicking Run as Administrator on the shortcut menu. 

2. On the Welcome to the Deltek Touch Maconomy 3.0 Installation Wizard page, click Next.  

3. On the License Agreement page, review the license agreement, select the I accept the 
terms of the license agreement option, and click Next. 

4. On the Select Web Server Type page, select one of the following options, and click Next: 

 Apache Web Server 

 IIS 

5. On the Maconomy Product Information page, provide the necessary information, and 
click Next: 

 Maconomy MScript URL – Enter the full Maconomy Touch URL (for example, 
http://eu100242:20003/cgibin/Maconomy/MaconomyTouch.w16de.en_US.exe).  

 Charset –You can only edit this field  if you are performing a new install. Select a 
character set from the drop-down list. 

 

The default character set is ISO-8859-1. If you are on Maconomy 2.1.1 (or higher) , you 
need to change the character set manually in configuration.ini from ISO-8859-1 to UTF-
8. 

 Maconomy 2.2.4 or later – Select this option if your Maconomy core is 2.2.4 or later. 

 

If this option is not marked,  you will not be able to set up Touch to use the RESTful 
web services. If your Maconomy version is 2.2.4 / 2.3 GA or later, then is very important 
to mark this option, to be able to set up REST for Touch.  

6. On the IIS Website Information page, select or enter the default Web site, and click Next. 

 

Select the Please check the box if the website is configured for SLL check box to 

use the HTTPS protocol when transmitting data over the Internet. 

If no site displays in the drop-down list, make sure you completed the steps from 
Microsoft IIS Web Server configuration on Windows Server from the previous section.  



 

 

If you do not have an IIS site already, starting with Touch 3.0, it is now possible to create 
a dedicated IIS Site for Deltek Touch, within the Touch installer. Click New Site button if 
you wish to create a new IIS Site.You will need to supply the following details: 

a. Site Name – Name of your new IIS Web Site 

b. Physical Path – Local directory for locating your web site 

c. Binding 

i. Type – HTTP or HTTPS 

ii. IP Address 

iii. Port Number 

iv. Host Name 

v. SSL Certificate (visible if type is HTTPS) 

 

7. Take one of the following actions, depending on the selected Web server type in step 4 
and the selection you make for the Maconomy 2.2.4 or later option in step 5: 

Apache Web Server IIS 

If you selected Apache Web Server but do 
not select Maconomy 2.2.4 or later in step 
5, the Choose Apache Installation Directory 
page displays. Proceed to step 8.. 

If you selected IIS in step 4 but do not 
select Maconomy 2.2.4 or later in step 5, 
the Choose Application Install Directory 
page displays. Proceed to step 11. 

If you selected Apache Web Server in 
step 4 and Maconomy 2.2.4 or later in 
step 5, the REST Proxy Data page 
displays. Provide the necessary 
information, and click Next. 

 Host Name – Enter the host name of 
the REST endpoint machine (for 
example, touch.<company 
name>.com). 

 Port Number – Enter the port number 
if there is a specific port connecting to 
REST endpoint. 

 Language – Enter a specific 
Language to use in Maconomy core 
(for example, en-US). 

 Database – Enter the short name of 
the Maconomy core. 

Proceed to step 9. 

If you selected Apache Web Server in 
step 4 and Maconomy 2.2.4 or later in 
step 5, the REST Proxy Data page 
displays. Provide the necessary 
information, and click Next. 

 Host Name – Enter the host name of 
the REST endpoint machine (for 
example, touch.<company 
name>.com). 

 Port Number – Enter the port number 
if there is a specific port connecting to 
REST endpoint. 

 Language – Enter a specific 
Language to use in Maconomy core 
(for example, en-US). 

 Proxy Pass Client Code – Enter the 
first pattern from rewrite rules if 
applied (for example, in 
resttouch/containers/*, the value is 
“resttouch”). 

 Database – Enter the short name of 
the Maconomy core. 

 IIS Site Name – Enter the IIS 
application name on where the rewrite 
rules are applied (for example, 



 

 

Apache Web Server IIS 

DeltekTouch). If the rewrite rules are 
set to IIS Site Level (for example, 
Default Web Site), this field should be 
blank.. 

All these fields (except Host Name) will 
have default values derived from the URL 
you entered on the Maconomy Product 
Information page, respectively the data you 
specified on the IIS website Information 
page. 

8. On the Choose Apache Installation Directory page, verify if the default location for the 
Apache Web software is correct, and click Next. Otherwise, click Browse to navigate to 
the installation folder, and click Next. Proceed to step 11. 

 

The default folder is C:\Program Files (x86)\Apache on a 64-bit machine or C:\Program 
Files\Apache on a 32-bit machine. 

 

If you selected Apache Web Server, the files are installed onto 
<INSTALL_DIR>\htdocs\DeltekTouch\Maconomy\Time_<MaconomyLanguage>. If 
multiple instances of Deltek Touch for Maconomy are installed (using the same 
Maconomy language) on Apache Web server, the folder name will be incremented. 

For example: 

1st instance - 

<INSTALL_DIR>\htdocs\DeltekTouch\Maconomy\Time_<MaconomyLanguage> 

2nd instance - 

<INSTALL_DIR>\htdocs\DeltekTouch\Maconomy\Time_<MaconomyLanguage>_1 

3rd instance - 

<INSTALL_DIR>\htdocs\DeltekTouch\Maconomy\Time_<MaconomyLanguage>_2 

You can rename the “Time_<MaconomyLanguage>_<number>” folder after the install; 
the updated folder name will reflect on the URL. 

9. On the REST Module Setup, select the setup for REST Module and click Next: 

 Use for Time – Select this option to use RESTful Web service for time registration. If 
not selected, it uses the MScript Web service. 

 Use for Expense – Select this option to use RESTful Web service for expense and 
mileage registration. If not selected, it uses the MScript Web service. 

By default, the two options are not selected 

10. On the Maconomy Coupling Service Endpoint page, this only displays when one of the 
REST Module is selected. Enter the coupling service details and click Next. 

 Hostname – This is the hostname/IP from the Maconomy Coupling Service. Auto- 
populated from MScript URL. 

 Port Number – This is the port number from the Maconomy Coupling Service. 

11. On the Choose Application Install Directory page, verify if the default location for the 
Deltek Touch software is correct, and click Next. Otherwise, click Browse to navigate to 
the installation folder, and click Next. Continue with the next page (10). 



 

 

 

If you selected IIS, the default folder is C:\Program Files (x86)\Deltek\Touch on 64-bit 
machine or else C:\Program Files\Deltek\Touch on 32-bit machine. You can run the 
installer multiple times to install several instances of Deltek Touch for Maconomy. Each 
instance, however, requires a new virtual directory pointing to a different physical 
location (Install Directory).. 

12. On the Pre-Installation Summary page, review the installation details that you provided. 
The set of information details on the Pre-Installation Summary page varies, depending on 
the Web server type that you selected in step 4. 

 If you want to change any settings, click Back, and make the necessary updates.  

 If you are done, click Install to begin the installation. 

 

If there are errors, the DeltekTouchInstall.log file displays. For Apache Web Server, 
the log file is saved in the C:\Program Files\Apache folder. For IIS, the log file is saved 

in the Application Install folder.  

You can test the REST Container URL specified on the screen. 

13. When the installation is done, on the InstallShield Wizard Complete page, click Finish. 

 

If you selected Apache Web Server, restart the Apache Windows service for the changes to 

take effect. 

For Apache, the default URL is https://<server>:<port>/deltektouch/maconomy/time/, where 
<server> refers to the host name of your Deltek Touch Server and <port> refers to the port 

number that the Maconomy server uses to listen for requests. 

For IIS, the default URL is usually https://<server>/deltektouch/maconomy/time/. 



 

 

Deltek Touch for Maconomy Installation on Linux 
Server 

Perform this procedure if you are going to install the Deltek Touch for Maconomy application on 
Linux server.  

 

A prerequisite for Deltek Touch is PHP. On RHEL 5.x, Deltek Touch has been tested with PHP 
5.3.3. On RHEL 6.x, Deltek Touch used PHP 5.6.5. 

Prerequisite 

Before you proceed with the PHP upgrade, make sure that you alter the channel subscription and 
select the optional repository.  

 

For more information, see http://snippets.roozbehk.com/post/35750940300/php-mbstring-
missing-on-red-hat-enterprise-linux-6. 

 

RHEL 5.6  

The recent version is PHP 5.3.3 with Apache 2.2.3. 

In the terminal window, run the following commands: 

1. yum install php533 

2. yum install php53-mbstring.x86_64 

RHEL 6.0 and 6.5 

The recent version is PHP 5.6.25 with Apache 2.4. 

For the Apache 2.4 installation, complete the following steps: 

 

If Apache 2.2 is installed, you should stop the original httpd (Apache 2.2) because the 
configurations would overlap. In addition, you should disable automatic startup of Apache 2.2 if 
enabled). 

1. Download the file rhscl-httpd24-epel-6-x86_64-1-2.noarch from the following link: 

https://www.softwarecollections.org/repos/rhscl/httpd24/epel-6-x86_64/noarch/ 

2. From WinSCP, copy the file from Windows to RHEL /var/tmp. 

3. In the terminal window, run the following commands: 

a. rpm –i  rhscl-httpd24-epel-6-x86_64-1-2.noarch.rpm 

b. yum install httpd24 

c. ps –ef | grep httpd 

d. /etc/init.d/httpd24-httpd start 

http://snippets.roozbehk.com/post/35750940300/php-mbstring-missing-on-red-hat-enterprise-linux-6
http://snippets.roozbehk.com/post/35750940300/php-mbstring-missing-on-red-hat-enterprise-linux-6
https://www.softwarecollections.org/repos/rhscl/httpd24/epel-6-x86_64/noarch/


 

 

For the PHP 5.6.25 installation/upgrade, complete the following steps: 

 

At this point, you may get a prompt stating that there are one or more dependencies missing 
from the system that should also be installed. You perform the installation manually because this 
is an SCL package and yum cannot install the dependencies automatically. 

In the terminal window, run the following commands: 

1. yum list | grep rh-php56*   

2. yum update rh-php56-php.x86_64 

3. /etc/init.d/httpd24-httpd restart 

 

If Deltek Touch is still not working, perform the following actions after you complete any of the 
installation above, depending on your RHEL version. 

1. Execute the command sudo setsebool -P httpd_can_network_connect on. 

2. Launch the Dletek Touch Web site. 

 

Before you perform the installation procedure, make sure that you rename DeltekTouch folder 
found on the specified location for Apache Web Root inside installDeltekTouch.sh file to 
DeltekTouchPrev. By default, the location is set to /var/www/html. 

cd <location specified in Apache Web Root parameter>  

mv DeltekTouch DeltekTouchPrev 

The file name where the location of the Web root parameter is set is as follows: 
/../../Linux/installDeltekTouch.sh. 

To install the application, complete the following steps: 

1. Copy DeltekTouchMaconomyLinux30.tar and save it to a temporary folder on a Linux 
machine. 

2. Extract the TAR file using tar -xvf DeltekTouchMaconomyLinux30.tar. The files are 
extracted to the Linux sub-directory. 

3. Update the following properties in install DeltekTouch.sh within the section enclosed in 
"------------------------------------". 

 APACHE_PORT 

 SVR_NAME  

 CHARSET 

 PHP_INSTALLED  

 APACHE_WEB_ROOT  

 INSTALL_DIRECTORY 

 URLDomain 

 CLIENTURL 

 MACONOMY_224UP 

If the current Maconomy core is 2.2.4 or later, provide details for the following entries: 

 REST_HOST_NAME 

 REST_PORT_NUMBER 

 REST_LANGUAGE 



 

 

 REST_DATABASE 

 USERESTFORTIME 

 USERESTFOREXPENSE 

4. Run the following command from the terminal to install the software: 

 ./installDeltekTouch.sh 

 

Make sure you run the command as root user.  

5. After the installation, restart the Apache Web server for the changes to take effect. 



 

 

Deltek Touch for Maconomy Setup 

This section contains information on how to set up Deltek Touch for Maconomy, corresponding 
service pack, hot fix, Web services, and related configuration settings. 

Maconomy MScript Web Services 

This section is mandatory. It includes the installation of the MScript Web services.  

 

Even if you prefer to use the RESTful Web services, you still need to have the MScript Web 
services installed. 

MConfig 

Deltek recommends that you use the latest MConfig version, which you can downloaded from 
DSM, under the release corresponding to your Maconomy version. Your MConfig version must be 
at least 8.17. 

Maconomy Service Pack 

 If you are using Maconomy X1 Service Pack 24 or lower, you must upgrade to Service Pack 
25 or later, which you can download from DSM.  

 

If you are using Maconomy X1 Service Pack 25, you do not have to do anything in this 
step.  

 If you are using Maconomy 2.0 Service Pack 2 or lower, you must upgrade to Service Pack 3 
or higher, which you can download from DSM.  

 

If you are using Maconomy 2.0 Service Pack 3 or higher, you do not have to do 
anything in this step.  

 If you are using Maconomy 2.1 (GA) or lower, you must upgrade to 2.1.1 or higher, which you 
can download from DSM.  

 

If you are using Maconomy 2.1.1 or higher, you do not have to do anything in this step.  

 

 If you are using Maconomy 2.2 LA, you must upgrade to 2.2 GA or higher, which you can 
download from DSM.  

 

If you are using Maconomy 2.2 (GA) or higher, you do not have to do anything in this 
step.  

 

  



 

 

Maconomy Hot Fix 

You need to install the Hot Fix containing the latest Maconomy Web services for Touch.   

 

The hot fix contains only the files needed for Touch Time, and no dictionaries. 

Starting with Touch 3.0, Touch is part of a specific Maconomy release. 

As a consequence, the Hot Fix is available only for specific Maconomy releases. 

The Touch 3.0 FPU is available in DSM only for Maconomy 2.2.6 and 2.1.8 CU5. 

 If you are using Maconomy 2.1, you need to install Maconomy 2.1.8 CU5, inclusive  
fpu.w1600.touchapi_3_0_0_0.zip, which you can download from under the 
Maconomy 2.1.8 cumulative releases.  

 If you are using Maconomy 2.2, you need to install Maconomy 2.2.6, inclusive 
fpu.w1700.touchapi_3_0_0_0.zip, which you can download from under the 
Maconomy 2.2.6 release. 

 If you are using Maconomy 2.3, you need to wait for Maconomy 2.3.4. 

 If you are using Maconomy 2.4, you need to wait for Maconomy 2.4.3. 

The hot fix will no longer be installed the same way as an application patch. 

To install the hot fix, in MConfig (8.17 or later), please select the hot fix in the Touch FPU field, 
instead of the Application patch field, as illustrated. It is recommended that you select and install 
the translations FPU at the same time as the Touch FPU. 

  



 

 

Install MScript Web Services 

If the Maconomy system has already had Touch installed, when installing the FPU, you are 
prompted to apply it to the Web server. ClickYes. This action installs the Touch Web service 
on the Maconomy Web server, so you do NOT need to do it manually. 

If you do not get this message, you need to apply the Web service using MConfig on the 
Maconomy Web server manually: 

1. On the Web product, select the MScript option. 

2. From the (Re)install Deltek Touch framework drop-down list, select the Install 
unconditionally option. 

 

 

Check if the Web services are customized and notify the relevant parties to update the 
customizations manually. The Web service is customized if there is a Custom or Solution folder 
in MaconomyMScript folder on the Web server. If these folders contain files (for example, 
DeltekTouh.I), the person who created the file must be notified to update it manually based on 

the changes to the file with the same name in the Standard folder. 

Install MaconomyTouch CGI Program 

Starting with 1.4, Touch will use MaconomyTouch CGI program, instead of MaconomyMScript. 
Switching to MaconomyTouch CGI is necessary for security reasons because it enforces a 
default timeout of one hour. 

Check your Maconomy Web server if it has already had MaconomyTouch.*.exe and 
MaconomyTouch.*.I (in …/cgi-bin/Maconomy). 

 If so, the MaconomyTouch CGI program is already installed. 



 

 

 Otherwise, you can install MaconomyTouch like any CGI program using  MConfig. From the 
(Re)install CGI programs drop-down list, select the Install unconditionally option. 

In using Deltek Touch for Maconomy, make sure that session cookies are disabled. You can set it 
in the related MaconomyTouch.I file using the following parameters: 

SessionCookies=0  

 

This only applies to Maconomy X1. In 2.0 and higher, it is done automatically. 

Update configuration.ini 

Make sure that configuration.ini is using the MaconomyTouch CGI program, instead of 
MaconomyMScript, in URL.  

The configuration.ini structure has been changed. It contains only the URL (instead of URL, 
MSCRIPTNAME and LANGUAGE). Make sure that the URL is containing the full path (for 
example, URL='http://myhost:20003/cgi-
bin/Maconomy/MaconomyTouch.w16de.en_US.exe/Standard/DeltekTouchWS.ms'). 

Install Dictionaries 

This section is optional. It is only needed if you want to localize Deltek Touch. 

For translating Touch to Danish, Swedish, Norwegian or Dutch, you have to install the 
dictionaries using MConfig. On the Application page, select the latest translations FPU available 
for your Maconomy version in the Translation FPU field under the Touch FPU field. 

 

Dictionaries are no longer included in the Touch FPU, but nstead they are in a separate 
translations FPU. 

To install additional dictionaries, select the languages you want to install from the Language 
drop-down list. 



 

 

 

  



 

 

Maconomy RESTful Web Services 

This section is optional. It is only needed if you want to use the RESTful Web services in Deltek 
Touch. 

One of the major changes in Touch 2.2 is that it allows you to use the Maconomy RESTful Web 
services in certain functional areas. 

Functional Area RESTful Web Services MScript Web Services 

Time Registration X X 

Expense Registration X X 

Mileage Registration X X 

Approvals - X 

Purchase Orders X - 

Absence and Allowance X - 

The main prerequisite for using RESTful Web services is Maconomy 2.2.4 / 2.3 GA / 2.4 LA 1 or 
later. 

If you meet this prerequisite: 

 For new installations: Deltek highly recommends that you use RESTful Web 
services, wherever possible because of the new functionality is available only on this 
Web service The Deltek Touch Installer also recommends that you the use of 
RESTful Web services. 

 

For more information, see the Deltek Touch for Maconomy MScript and RESTful  Web 
Services Comparison Guide. 

 For upgrades: Deltek recommends that you use RESTful Web services. If the 
customer prefers to stay on MScript Touch, you can turn of the RESTful Web 
services after the upgrade. There are other important aspects that you should be 
taking into account when deciding which web service you would like to use. 

 

For more information, see the Deltek Touch for Maconomy Upgrade Guide. 

Using the RESTful Web Services in Deltek Touch 

Enable RESTful Web Services in Maconomy 

The RESTful Web services need to be enabled in the Coupling Service. If this is already the 
case, continue with the Proxy Server setup. Otherwise, perform the instructions discussed in this 
section. 

To enable the RESTful Web services, complete the following steps:  

1. Right-click the MConfig executable, select Run as administrator, and follow the prompts 
accepting all default values.  



 

 

2. In the MConfig Main window, double-click the application to open.  

3. In the Application Instance window, click OSGi products. 

 

4. On the OSGi Server Selection screen, select the Coupling Service to update. 

 

5. Select the Enable RESTful Web Services option. 

 

6. Click OK to save. 

7. When the SSL warning displays, click OK to return to the Application Instance window. 



 

 

8. Click OK to accept the changes and return to the main screen.  

9. Click Next, Next, and Yes to complete the installation. 

Proxy Server Setup 

Apache 

To enable the proxy server in Apache, complete the following steps:  

1. Open the “httpd.conf” file. 

2. Add the following line of codes: 

ProxyRequests Off 

ProxyPreserveHost On   

3. Add the “ProxyPass” for containers and filedrop REST API, for example:   

ProxyPass  /containers  http://10.1.1.11:1111/containers retry=0 

ProxyPass  /filedrop    http://10.1.1.11:1111/filedrop   etry=0 

4. Restart the Apache Server. 

IIS 

If you use the Touch 2.2 (or higher) Installer to install a new REST Touch or upgrade to 
REST Touch, most of the steps described below will be done by the Installer: 

 Install the Microsoft IIS URL Rewrite 2.0 

 Install the Application Request Routing (ARR) 

 Set server variable HTTP_X_FORWARDED_PROTO 

 Create rewrite rules for container and filedrop 

 Update configuration.ini 

 Enable preserveHostHeader 

The only remaining manual setup step is for switching to using HTTPS. 

In case you do not use the Installer, as specified above, respectively if your installation is not 
successful, you can find below the description of the manual steps needed to be performed by 
you for setting up the REST proxy on IIS. 

Before you set up the proxy server in IIS, you need to install the Microsoft IIS URL Rewrite 2.0 
and install the Application Request Routing (ARR). 

 

 For more information on IIS URL Rewrite, see http://www.iis.net/downloads/microsoft/url-
rewrite. 

 For more information on installing the ARR plugin, see http://www.microsoft.com/en-
us/download/details.aspx?id=39715. In IIS 8.0 and 8.5, you need to install the “Web 
Platform Installer” before you can install the ARR plugin. 

 

1. Restart IIS Manager. 

2. In the “Application Request Routing” configuration window, click Server Proxy Settings. 

3. Select Enable proxy. 

http://www.iis.net/downloads/microsoft/url-rewrite
http://www.iis.net/downloads/microsoft/url-rewrite
http://www.microsoft.com/en-us/download/details.aspx?id=39715
http://www.microsoft.com/en-us/download/details.aspx?id=39715


 

 

 

To perform the proxy server setup, complete the following steps:  

1. Add the rewrite rules for the proxy in the IIS manager. First click the website where you 
want to define the rewrite rules.  

Deltek recommends that rules must be added to the local site (for example, DeltekTouch) 
not to the root site (for example, Default Web Site). 

 

2. Click the applet “URL Rewrite.”  

3. Add the rules for “containers” REST API for specific client. For more information, see the 
Add Rules to “containers” REST API section. 

4. Add the rules for “filedrop” REST API for specific client. For more information, see the 
Add Rules to Filedrop API section. 

5. Restart the IIS Manager. 

  



 

 

Set Up HTTPS 

To set up HTTPS, complete the following steps: 

1. Open the URL Rewrite applet. 

2. In the Actions pane, click View Server Variables.... 

3. On the Server Variables window, click Add... and add the variable 
HTTP_X_FORWARDED_PROTO. 

4. In the configuration.ini file, change the REST_HTTP_PROTOCOL to https and 
REST_DOMAIN_NAME (if not set) to an external URL accessible thru Internet. (for 
example, touch.deltek.com). 

5. Restart the Web server. 

Add Rules to the “containers” REST API  

The rules can be added on application or site level: 

1. If the rewrite rules are on the IIS application, you must specify both 
REST_IIS_TOUCH_FOLDER_NAME and REST_PROXY_PASS_CLIENT_CODE 

2. If the rewrite rules are on the IIS site, both REST_IIS_TOUCH_FOLDER_NAME and 
REST_PROXY_PASS_CLIENT_CODE should be empty. 

To add the rules to container API, complete the following steps:  

3. Open the URL Rewrite applet. 

4. In the Actions pane, click Add Rule(s).  

5. On the Add Rule(s) dialog box, select the Blank Rule option in the Inbound rules 
section. 

 

6. Click OK. 

7. On the Edit Inbound Rules window, enter or select the appropriate values: 



 

 

 

 Name – Set the rule name (for example, Containers). 

 Requested URL – Select the Matches the Pattern option. 

 Using – Select the Wildcards option. 

 Pattern – Enter the pattern, for example, proxycode/containers/*. 

 Ignore case – Select this option. 

 Conditions – Do not change anything. 

 Server Variables – Add the HTTP_X_FORWARDED_PROTO with an https value if 
the Touch server is setup with https. Otherwise, use http. Checked the ‘Replace the 
existing value.’ 

 Action 

 Action type – Select the Rewrite option. 

 Action Properties 

 Rewrite URL – Enter the URL for the RESTful API, for example,  
http://10.1.1.111:1111/containers/{R:1}. 

 Append query string – Select this option. 

 Log rewritten URL – Do not select this option. 

 Stop processing of subsequent rules – Do not select this option. 

8. On the right pane, click Apply. 



 

 

Add Rules to the Filedrop API 

To add the rules to the filedrop API, complete the following steps:  

1. Open the URL Rewrite applet. 

2. In the Actions pane, click Add Rule(s).  

3. On the Add Rule(s) dialog box, select the Blank Rule option in the Inbound rules 
section. 

4. Click OK. 

5. On the Edit Inbound Rules window, enter or select the appropriate values: 

 Name – Set the rule name (for example, Filedrop). 

 Requested URL – Select the Matches the Pattern option. 

 Using – Select the Wildcards option. 

 Pattern – Enter the pattern, for example, proxycode/filedrop/*. 

 Ignore case – Select this option. 

 Conditions – Do not change anything. 

 Server Variables – Add the HTTP_X_FORWARDED_PROTO with an https value if 
the Touch server is setup with https. Otherwise, use http. Checked the ‘Replace the 
existing value.’ 

 Action 

 Action type – Select the Rewrite option. 

 Action Properties 

 Rewrite URL – Enter the URL for the RESTful API, for example,  
http://10.1.1.111:1111/filedrop/{R:1}. 

 Append query string – Select this option. 

 Log rewritten URL – Do not select this option. 

 Stop processing of subsequent rules – Do not select this option. 

6. On the right pane, click Apply. 

Preserve Host Header 

1. Open a console with Administrative privileges, and navigate to the following folder: 

C:\Windows\System32\inetsrv  

2. Enable preserveHostHeader by running the following command: 

cd C:\Windows\System32\inetsrv 

appcmd.exe set config -section:system.webServer/proxy 

/preserveHostHeader:"True" /commit:apphost 

3. Restart the Web server. 

  



 

 

Update configuration.ini 

This procedure allows you to update the configuration.ini file. 

To update the configuration.ini file, complete the following steps: 

1. Make sure that the [REST_PROXY_DATA] section has the correct information. 

For example: 

[REST_PROXY_DATA] 

REST_HTTP_PROTOCOL="https" 

REST_DOMAIN_NAME="<yourdomain>.com” 

REST_HTTP_PORT="" 

REST_CONTAINER_NAME="containers" 

REST_FILEDROP_NAME="filedrop" 

REST_VERSION="v1" REST_DATABASE="m19rs1" 

REST_LANGUAGE="en-US" 

REST_AUTHENTICATION_TYPE="BASICAUTH " 

2. Change the settings in the [REST_MODULE_SETUP] section according to your need: 

 Set USERESTFORTIME="true" if you want to use the RESTful Web services for time 
registration 

 Set USERESTFOREXPENSE="true" if you want to use the RESTful Web services 
for expense and mileage registration 

 It is mandatory to keep USERESTFORAPPROVALS="false" because Deltek Touch 
2.0 does not support RESTful Web services in approvals. 

configuration.ini 

The configuration.ini is a setting file utilized by Deltek Touch to provide environment information to 
the Touch application.  



 

 

 

Existing Parameters 

; ********************************** 

;  Maconomy Touch Configuration File 

; ********************************** 

[SERVER_DATA] 

URL=”” 

CHARSET=”” 

DYNAMICSCRIPT=”” 

DEBUGGERFL=”” 

TOUCHSERVERVER=”” 

HELPDOCURL = “” 

CLIENTURL=”” 

  



 

 

New Parameters 

In Deltek Touch 3.0, the following parameters have been added to enhance security: 

[SERVER_DATA] 

REQUIREDEVICEPASSCODE="" 

ALLOW_BIOMETRICS="" 

Description of the New Parameters 

[SERVER_DATA] 

 REQUIREDEVICEPASSCODE: Controls how Touch handles users who don’t have a 
passcode on their device. By default is true, which means that if a user does not have a 
passcode set on his/her mobile device, then the user will not be able to use Touch. You 
can change it to false, to make device passcode use optional for Touch, which means 
that if a user does not have a passcode set on his/her mobile device, the user will still be 
able to use Touch. 

 ALLOW_BIOMETRICS: This parameter determines if users are allowed to use biometric 
authentication (fingerprint or facial recognition) as alternative to PIN. By default is false, 
meaning biometric authenticatin is not allowed; users will authenticate using PIN. If you 
set it to true, users will have the option in the app, to choose between authenticating 
using PIN, fingerprint and facial recognition. Note: This setting will be used when you 
upgrade to Maconomy 2.4.3. 

 

In Deltek Touch 2.2, the following parameters have been added to support the enhanced PIN 
security.  

The new parameters are divided into two sections: REST_PROXY_DATA (which contains 
connection details parameters) and REST_MODULE_SETUP (contains parameters responsible 
for enabling the REST functionality in the time, expense, and approvals modules). 

[SERVER_DATA] 

ANALYTICSKEY="" 

 

[PIN_SETTINGS] 

MIN_LENGTH="" 

COMPLEXITY="" 

UNIQUE_HISTORY="" 

PIN_EXPIRATION="" 

REST_PROXY_DATA 

Description of the New Parameters 

[SERVER_DATA] 

  ANALYTICSKEY – This parameter is used for customer specific statistics based on Google 
Analytics 

[PIN_SETTINGS] 

 MIN_LENGTH – This parameter represents the minimum PIN length, which is set to 6 by 
default is 6 and allows 4-12 characters. 

 COMPLEXITY – This parameter represents the PIN complexity feature. It prevents you from 
using all the same numbers or a sequence of numbers in your PIN. It is set to true by default. 



 

 

 UNIQUE_HISTORY – This parameter represents the limit PIN reuse. it does not allow you to 
use the same PIN over and over. By default, it is set to "0," which means you can reuse PIN. 
It accepts values from 0 to 6. 

 PIN_EXPIRATION – This parameter represents the limit on how long a PIN is valid before 
requiring you to change it. By default, it is set to 90 days. It accepts values from 0 (which 
means no limit) to 90. 

 

In Deltek Touch 2.0, the following parameters have been added to support the Maconomy 
RESTful Web service and multi-tenant setup. These parameters are divided into two sections: 
REST_PROXY_DATA (which contains connection details parameters) and 
REST_MODULE_SETUP (contains parameters responsible for enabling the REST functionality in 
the time, expense, and approvals modules). 

[REST_PROXY_DATA] 

REST_HTTP_PROTOCOL=”” 

REST_DOMAIN_NAME=”” 

REST_HTTP_PORT=”” 

REST_PROXYPASS_CLIENT_CODE=”” 

REST_CONTAINER_NAME=”” 

REST_FILEDROP_NAME=”” 

REST_VERSION=”” 

REST_DATABASE=”” 

REST_LANGUAGE=”” 

REST_IIS_TOUCH_FOLDER_NAME=”” 

REST_AUTHENTICATION_TYPE=”” 

 

[REST_MODULE_SETUP] 

 USERESTFORTIME=”” 

USERESTFOREXPENSE=”” 

USERESTFORAPPROVALS=”” 

REST_PROXY_DATA 

 REST_HTTP_PROTOCOL – This parameter is set by the Touch Installer to "https." It 
represents the protocol (HTTP/HTTPS) used on the REST requests initiated from the 
Touch client. You can change it in the configuration.ini to "http," if you are in an early 
phase of the Touch installation and you do not have an SSL certificate yet. However, 
you can test Deltek Touch only using the Web application. Before you complete the 
Deltek Touch installation, you must have this parameter set to "https," else the Touch 
native apps will not work. 

 REST_DOMAIN_NAME – This is the host name of the Touch Server. It refers to the 
computer name or the IP address of the Touch Server. 

 REST_HTTP_PORT – This is the associated port number from the host name of the 
Touch Server. If the REST Web service is running in a secured layer, it should be in 
443. Otherwise, leave this field blank or set it to the appropriate value.  

 REST_PROXYPASS_CLIENT_CODE– Enter the first pattern from REST API set in 
the rewrite rules. For example, in resttouch/containers/*, the value on this parameter 
should be “resttouch”.   

 

The first pattern from container rule should be the same with filedrop rule (or vice-
versa), for example, resttouch/filedrop/*. 



 

 

 

 REST_CONTAINER_NAME – Enter containers. 

 REST_FILEDROP_NAME – Enter filedrop. 

 REST_VERSION – Enter v1. 

 REST_DATABASE – This is the database name of the RESTful Web service.  

 REST_LANGUAGE – This is the locale code. Typically, this parameter is the same 
value as the language being set up for Mscript. 

 REST_IIS_TOUCH_FOLDER_NAME – This is only used if the Deltek Touch is 
hosted using IIS and the rewrite rules to access the REST API have not been 
configured in the IIS Site Level (for example, Default Web Site). 

 

To determine if the rewrite rules have been configured in the root Web site, you need to 
open the IIS URL Rewrite. 

 

In the event that you need to add the rewrite rules (REST API) on the IIS Site Level, 
leave this parameter blank. 

How to set the value of REST_IIS_TOUCH_FOLDER_NAME? 



 

 

If the rewrite rules for accessing the REST_API have not been placed in the root Web 
site, set the value of this parameter using the name of the Web site where the rewrite 
rules were configured. 

 

For example, in the screenshot, the rewrite rules are in the Deltek Touch web site. In the 
Input column, the URL path after ‘/DeltekTouch/ value displays. In this case, use 
DeltekTouch as the value for the parameter. 

 REST_AUTHENTICATION_TYPE – The value for this parameter is “BASICAUTH.” 

REST_MODULE_SETUP 

 USERESTFORTIME – Valid values are true or false. True means the time 
registration functionality uses the REST API. False means it uses MScript.  

 USERESTFOREXPENSE – Valid values are true or false. True means the expense 
and mileage sheet functionality uses the REST API. False means it uses MScript. 

 USERESTFOREXEPENSE – Deltek Touch 2.0 must use the false value. 

Server Side Configuration Settings 

This section is optional. You can modify the following configuration options that are included in 
the MaconomyMScript\Standard\DeltekTouch.I. 

Key Valid Options Default 
Value 

Description 

Submit Daily, Weekly Weekly This option specifies whether you 
register and submit time on a daily or 
weekly basis. 

searchMaxRowcount 0-100 30 This is used to restrict the number of 
rows that a search returns. 

searchtext Search Search This option is NOT used in this 
release. 

debug true or false False This does not apply to REST.  

This options works in Touch 1.x, and 
MScript Touch 2.0. If you set debug = 
true, it logs some of the error 



 

 

Key Valid Options Default 
Value 

Description 

messages occurring when using the 
MScript Web service. 

IncrementalMinutes Minutes Empty This option controls the increment 
used in the hour picker. If empty, it 
usse the Registration Unit user 
settings specified on the Settings 
screen of Touch. The Registration 
Unit user setting has priority over the 
IncrementalMinutes server setting. 
This server setting is usefull to set the 
default increment for all users, but 
users have the option to overwrite this 
in the user setting. 

For example: if IncrementalMinutes is 
set to 15, you can enter hours like 
1:00, 1:15, 1:30, 1:45 in the 
application. 

IncrementalDays Real Empty This option controls the increment 
used in the day picker. If empty, it 
uses the Registration Unit user 
settings specified on the Settings 
screen of Touch. The Registration 
Unit user setting has priority over the 
IncrementalDays server setting. This 
server setting is usefull to set the 
default increment for all users, but 
users have the option to overwrite this 
in the user setting. 

For example: if IncrementalDays is 
set to 0.15, you can enter days like 

0, 0.15, 0.30, 0.45, 0.60 in 

the application. 

UseExternalCredenti
als 

true or false False This option controls whether you use 
external credentials (Kerberos or 
Azure). If you would like to be able to 
log on to Touch Time using your 
domain/network/Azure credentials, 
and Maconomy is set up to support it, 
then please set this option to true. 

ExternalCredentialsT
ype 

Kerberos or 
Azure 

Kerberos Specifies what kind of external 
credentials we support in Deltek 
Touch. Considered only if 
UseExternalCredentials = true, else 
the setting is ignored. 

Specifies which charset should be 
used for the external login credentials 
(user name, password, and domain 



 

 

Key Valid Options Default 
Value 

Description 

when using Kerberos SSO).  

If you experience issues with Danish 
characters in domain password, try 
changing it to iso-8859-1. 

ExternalCredentialsC
harset 

UTF-8 

ISO-8859-1 

UTF-8 Specifies which charset should be 
used for the external login credentials 
(user name, password, and domain 
when using Kerberos SSO).  

If you experience issues with Danish 
characters in domain password, try 
changing it to iso-8859-1 

AzureNativeClientID String Empty This setting is relevant only for Azure. 

 Represents the ClientID of the Azure 
native application, to be used by the 
Deltek Touch native application. 

AzureRedirectURI String Empty This setting is relevant only for Azure. 

Represents the Redirect URI of the 
Azure native application to be used by 
the Deltek Touch native application. 

AzureResponseType String Empty This setting is relevant only for Azure. 

Indicates which Azure login method is 
used.  

 
By default, it is empty, which means 
the Web service tries to calculate this 
based on the information it gets from 
Maconomy. You should explicitly set 
this,only if the default functionality 
fails, in which case the possible 
values are “code” and “token”: 

 If the value is “code,” Maconomy 
uses the AzureOpenID login 
method.  

 If the value is “token,” Maconomy 
uses the AzureAD login method. 

AzureTenantID String Empty This setting is relevant only for Azure. 

It represents the ID of the Azure 
tenant. 

By default, it is empty, which means 
the Web service tries to calculate this 
based on the information it gets from 
Maconomy. You should explicitly set 



 

 

Key Valid Options Default 
Value 

Description 

this,only if the default functionality 
fails. 

AzureWebClientID String Empty This setting is relevant only for Azure. 

It represents the ID of the Azure 
application used for the Touch Web 
application 

By default, it is empty, which means 
the Web service tries to calculate this 
based on the information it gets from 
Maconomy. You should explicitly set 
this,only if the default functionality 
fails. 

AzureServerID String Empty This setting is relevant only for Azure. 

It represents the ID of the Azure 
application used for the Maconomy  
server.  

By default, it is empty, which means 
the Web service tries to calculate this 
based on the information it gets from 
Maconomy. You should explicitly set 
this,only if the default functionality 
fails. 

ShowMissingTimesh
eetsDue 

true or false True This does not apply to REST.  

This option controls the status of 
missing (not created before the 
current date) daily timesheets. If true, 
the status is Due, else the status is 
New. 

WeekStart 0 (Sunday), 
1(Monday), 
2(Tuesday) 
3(Wednesday) 
4(Thursday) 
5(Friday) 
6(Saturday) 

1 This option controls which day 
displays as the first day in the 
Calendar. It can be overwritten by the 
“Week Start” user setting. The server 
setting is only the default value for the 
user setting. 

MandatoryRejection
Remark 

true or false True This option is available only in 
Maconomy 2.1.1 and higher. 

This option controls if you have to 
specify a rejection comment when 
rejecting a time sheet. 

 If true, you must specify a 
rejection comment, else you 
cannot reject. 



 

 

Key Valid Options Default 
Value 

Description 

 If false, the rejection comment is 
optional. 

CustomSbmitTimesh
eetAction 

String Empty 
string 

This does not apply to REST.  

The name of the custom action used 
for submitting time sheets, if any 

ShowOnlyPOLinesT
oApprove 

true or false True This option is available only in 
Maconomy 2.1.1 and higher. 

When approving purchase order lines, 
you see the entire purchase order. 

This setting controls which of the lines 
you want to see when approving PO 
lines 

 If true (default), it only displays 
PO lines you can approve. 

 If false, it displays all PO lines in 
the given PO, including the lines 
you can approve. 

ShowOnlyInvoiceAll
ocationLinesToAppr
ove 

true or false True This option is available only in 
Maconomy 2.1.1 and higher. 

When approving invoice allocation 
lines, you see the vendor invoice and 
its allocation. 

This setting controls which of the lines 
you want to see when approving 
invoice allocation lines.  

 If true (default), it only displays 
invoice allocation lines you can 
approve. 

 If false, it only displays all invoice 
allocation lines for the given 
vendor invoice, including the 
lines you can approve. 

NotificationRecalcul
ationInterval 

Integer 1800 This option is available only in 
Maconomy 2.1.1 and higher. 

This setting controls the frequency (in 
seconds) of recalculating the 
notification (approval and 

rejected time)counters in the 

background. 

 For disabling the background 
recalculation, use -1. 

 Setting under 5 min (300 sec) 



 

 

Key Valid Options Default 
Value 

Description 

may lead to performance 
penalties on the Maconomy 
server. 

CopyRemarkFromTi
meSheetLineToFavo
rite 

true or false False This option is available only in 
Maconomy 2.0  and higher. 

 

This setting controls if the Remark 
field should be copied from the time 
sheet line to the favorite when 
creating a new favorite based on a 
time sheet line  

If true, the Remark field value is 
copied from the timesheet line into the 
favorite (which is creaed from the time 
sheet line) 

If false, the Remark field value is 
NOT copied from the timesheet line 
into the favorite (which is creaed from 
the time sheet line) 

ExpenseAttachment
Type 

string “header 
and line” 

This option is available only in 
Maconomy 2.0  and higher. 

This setting controls where can you 
attach receipts to expenses. It can 
have one of the following values: 

 "none" = This value indicates 
that it is not possible to attach 
receipts to expenses at all. 

 "header" = This value indicates 
that it is possible to attach 
receipts only to the expense 
sheet header. 

 "line" = This value indicates that 
it is possible to attach receipts 
only to the expense sheet line. 

 "header and line" = This value 
indicates that it is possible to 
attach receipts to both the 
expense sheet header and line. 

ShowJobsWithEmpl
oyeeControl 

true or false False This option is available only in 
Maconomy 2.0  and higher. 

It allows you to see the employee's 
jobs (based on Employee Control) on 
the Find Job screen when creating a 
time sheet line using a job  



 

 

Key Valid Options Default 
Value 

Description 

 If true, the All tab displays the 
Recently used projects and My 
Job list (jobs the user has 
access to via Employee Control)  

  If false, the All tab displays the 
Recently used projects only 
list. 

ShowZeroHourJobsI
nSummary 

true or false True This option is available in all 
supported Maconomy versions.  

It controls the Summary screen, Job 
tab content. 

 If true (default): the time sheet 
summary will show all 
job/task/activity combinations, 
used in the selected weekly time 
sheet 

 If false: the time sheet summary 
will show only job/task/activity 
combinations, used in the 
selected weekly time sheet, 
which are having hours 
registered 

AllowNegativeHoursI
nTimeSheets 

true or false false This option is available in all 
supported Maconomy versions.  

Determines if you are allowed to enter 
negative hours on time sheet lines in 
Timesheet and Timesheet Line 
screens 

 If true: you are allowed to enter 
both positive and negative hours 
on time sheet lines  

 If false (default): you are allowed 
to enter only positive hours on 
time sheet lines 

AllowNegativeDaysIn
TimeSheets 

True or false false This option is available to all 
supported Maconomy versions.  

Determines if you are allowed to enter 
negative days on timesheet lines on 
the Timesheet and Timesheet Line 
screens 

 If this is set to true, you are 
allowed to enter both positive 
and negative days on timesheet 
lines.  



 

 

Key Valid Options Default 
Value 

Description 

 If false (default), you are allowed 
to enter only positive days on 
timesheet lines. 

ShowExpense true or false True This option is available only to 
Maconomy 2.0 and higher. 

To disable expense functionality for 
all users, set ShowExpense to false. 

ShowMileage true or false True This option is available only to 
Maconomy 2.0 and higher. 

To disable mileage functionality for all 
users, set ShowMileage to false. 

MaxAttachmentFileSi
ze 

Integer 1000 Determines the maximum file size (in 
KB) of the pictures attached to 
expense sheets in Deltek Touch. If 
set to 0, it will generate the smallest 
file size possible, but the quality might 
be low. This is recommended only if 
you experience performance 
penalties when attaching documents.  
If set to non-zero value, the 
functionality is unchanged; it will 
generate the highest quality possible 
for the given maximum file size. 

ShowPurchaseOrder Boolean true It controls whether users should be 
able to see the purchase order 
functionality in Deltek Touch.  

If you do not want any users to see 
purchase orders in Deltek Touch, set 
this setting to false. 

If you set it to true, all users having 
access to the Maconomy 
PurchaseOrders window can view 
purchase orders in Deltek Touch. 
Users still have the option to 
individually hide the purchase orders 
by changing the Show Purchase 
Orders user setting in the Deltek 
Touch. 

ShowAbsence Boolean true It controls whether users should be 
able to see the absence request 
functionality in Deltek Touch.  

If you do not want any users to view 
absence request s in Deltek Touch, 
set this setting to false. 



 

 

Key Valid Options Default 
Value 

Description 

If you set it to true, all users having 
access to the Maconomy 
AbsenceCalendarLines window can 
view absence requests in Deltek 
Touch. Users still have the option to 
individually hide the allowance 
requests by changing the Show 
Absence user setting in the Deltek 
Touch. 

ShowAllowance Boolean true It controls whether users should be 
able to see the allowance request 
functionality in Deltek Touch.  

If you do not want any users to view 
allowance request s in Deltek Touch, 
set this setting to false. 

If you set it to true, all users having 
access to the Maconomy 
AbsenceEntryOverview window can 
view allowance requests in Deltek 
Touch. Users still have the option to 
individually hide the allowance 
requests by changing the Show 
Allowance user setting in the Deltek 
Touch. 

ShowOnlyFavoritesI
nJobSearch 

Boolean false It determines the content of the job 
search (Find Job) screen, invoked 
from the Time, Expense and Mileage 
Sheet Line screens. 
If true, the job search (Find Job) 
screen shows only favorites. When 
creating a time, expense or mileage 
sheet line, you will only be able to 
select a favorite, not a job. 
If false, the job search (Find Job) 
screen shows jobs and favorites (All 
and Favorites tabs). When creating a 
time, expense or mileage sheet line, 
you will be able to select a favorite or 
a job. 

ShowDefaultExpens
eReceiptName 

Boolean false It allows you to see and use a default 
expense receipt name, when taking a 
picture to attach to an expense sheet, 
both in quick capture and expense 
sheets flow. 
 If true, a default receipt name will be 
shown. You might accept it or replace 
it. 
 If false, there is no default receipt 



 

 

Key Valid Options Default 
Value 

Description 

name, you must enter the receipt 
name yourself 

AllowMaconomyLogi
nWhenUsingExternal
Credentials 

Boolean false This setting is only a place-holder, the 
corresponding functionality will be 
added in a later Touch release. It has 
been added in the hope that our next 
Touch app-only release could 
implement the corresponding 
functionality. 
Therefore, changing the value of this 
setting will have no impact in the 
Touch 2.3 application. 

 

 

Before you change any of these settings, Deltek recommends that you make a copy of the 
DeltekTouch.I file in the MaconomyMScript\Standard folder and place it in the 
MaconomyMScript\Custom folder. Then, change the file in the Custom folder instead of the 
original file. 

 

For mor information about customization, see Deltek Touch for Maconomy Layout Configuration 
Guide. 

Touch with Azure Setup 

History of Azure setups supported by Maconomy and Touch 

 Maconomy 2.4 LA 1 and Touch 2.1 supports only the Azure OAuth setup. 

 Maconomy 2.4 LA 2 and Touch 2.1 supports only the Azure OAuth setup. 

 Maconomy 2.4 LA 2 and Touch 2.2 supports both the Azure OAuth and Azure OpenID setup. 

 Touch 3.0 only supports the Azure OpenID setup. Therefore, in order to be able to use 
Azure in Touch 3.0 (or later), you must have Maconomy 2.4 LA 2 (or later). 

Azure Setup for Maconomy 

For your reference, the following is a comparison of the previous and new protocol setups in 
Azure.  

Azure OAuth (Previous Setup) 

No longer supported in Touch 3.0 

Azure OpenID (New Setup) 

Supported in Touch 3.0 

Requires three applications to be set 
up in Azure: 

 Maconomy – Azure Web 
application for Maconomy Server 

 Touchapp – Azure native 
application for the Touch native 

Requires two applications to be set up in 
Azure: 

 Maconomy – Azure Web application 
for Maconomy Server, Maconomy 
clients, and Touch Web application 

 Touchapp – Azure native application 



 

 

Azure OAuth (Previous Setup) 

No longer supported in Touch 3.0 

Azure OpenID (New Setup) 

Supported in Touch 3.0 

application 

 Maconomy Client – Azure Web 
application for Touch Web 
application and Maconomy clients 

Note: The Touch apps gets an access 
token from Azure which is sent to 
Maconomy to authenticate the user. 

for the Touch native application 

 

 

Note: The Touch app gets an 
authentication code from Azure which is 
sent to Maconomy to authenticate the 
user. 

MConfig Setup for Azure 

For your reference, the following is a comparison of the previous and new protocol setups in MConfig. 

MConfig Azure OAuth (Previous 
Setup) 

MConfig Azure OpenID (New Setup) 

 Domain Login Method: Azure AD 

 Azure Tenant ID 

 Azure Client ID 

 Azure Server ID 

 

 Domain Login Method: Azure 
OpenID 

 Azure Tenant ID 

 Azure Client ID 

 Azure Client Secret 

If Maconomy is set up with Azure OpenID and you prefer your Deltek Touch installation to use 
Azure, you need to complete additional setup. 

 

It is a prequsite that Azure is set up for Maconomy as described in the Maconomy 
documentation. Prior to enabling the Azure setup in Deltek Touch, Deltek recommends to test 
Azure in Workspace Client. 

For more information, see the Deltek Maconomy Azure SSO Guide. 

Register an Azure Native Application for Touch Native Application 

This can be done using the new Azure Portal (https://portal.azure.com), 

To register an application for Touch, using the new Azure Portal, complete the following 
steps: 

1. Open the Azure Active Directory (AAD) in the Azure management portal. 

2. Click the App registrations tab. 

3. On the App registrations tab, click New application registration 

4. Enter Maconomy Touch as name, select Native Client Application as type, and enter 

https://deltekmaconomyclient for the REDIRECT URI.  

 

This will be the AzureRedirectURI. 

https://portal.azure.com/


 

 

 
5. Under the properties section of the newly created application, find the read-only field 

labeled Application ID and note its value. This is the Touch Client ID.  

 

This will be the AzureNativeClientID. 

 

 

6. Set the permissions on the application to give access to the Maconomy Server Azure 

application, using All settings » Required Permissions. 



 

 

 

Update the Maconomy Azure Application to Support the Deltek Touch Web 
and Native Applications 

The Deltek Touch Web application uses the same Azure application as the Workspace Client. If 
you follow the Maconomy documentation for Azure, this Azure Web app is called Maconomy. 

To make sure that Deltek Touch can use the Maconomy Azure application, add the Touch URL to 
the Reply URL on the Azure application. 

To add the Touch URL to the Reply URL, complete the following steps: 

1. Open AAD in the Azure management portal. 

2. Click the App regisrations tab. 

3. On the App registrations tab, find the Maconomy application. 

 

4. Click All Settings » Reply URLs. 

 

5. Add the Touch URL (for example, 
https://<yourdomain>.com/23_M24GARest/maconomyshared/backend/oauth2tokenretur
n.php) to the Reply URL. 

 

Depending whether your Maconomy system is set up with AzureAD or AzureOpenID 
domain login method, the Reply URLs to be set on the Maconomy Azure application 
(corresponding to the Maconomy server) differ as follows: 



 

 

 https://login.microsoftonline.com/common/oauth2/nativeclient - This is needed for the 
Maconomy Workspace Client and Coupling Service, in general. It should be part of the 
Maconomy  setup. 

 .../maconomyshared/backend/oauth2authorizereturn.php  (for 
example,  https://<yourdomain>.com/22_M20SP1/maconomyshared/backend/oauth2authoriz
ereturn.php,) - This is for Azure OpenID, for the Touch Web application. 

 …/maconomyshared/backend/oauth2authcodereturn.php. - This is for the Azure OpenID, for 
Touch native application. 

 

Turn On Azure Login in the Web Service 

The following changes are needed in the custom DeltekTouch.I file: 

1. Set UseExternalCredentials to true. By default, it is set to false. 

2. Set ExternalCredentialsType: #K”Azure”. By default, it is empty. 

3. Set AzureNativeClientID to the Touch Client ID (step 5 of the Register an Azure Native 
Application for Touch Native Application procedure). For example, 

AzureNativeClientID:#K"347bbd9d-15da-4564-b58f-1dfcadc7e2bf". By 

default, it is empty. 

4. Set AzureRedirectURI to the REDIRECT URI  (step 4 of the Register an Azure Native 
Application for Touch Native Application procedure). For example, 

AzureRedirectURI:#Khttps://deltekmaconomyclient. By default, it is empty. 

5. If Maconomy is set up to use AzureOpenID, you can specify the new server settings: 
AzureResponseType, AzureWebClientID, AzureServerID, AzureTenantID. By default 
these are empty, meaning the Web service tries to calculate these based on the 
information it gets from Maconomy. You should explicitly set this only if the default 
functionality fails. For AzureResponseType, the only value allowed is “code”.  

  

https://login.microsoftonline.com/common/oauth2/nativeclient
https://makapt9vs.ads.deltek.com/22_M20SP1/maconomyshared/backend/oauth2authorizereturn.php
https://deltekmaconomyclient/


 

 

Deltek Touch with Single Sign-On Setup 

If Maconomy is set up with Kerberos SSO and you prefer Touch to use SSO, you need to 
perform the following tasks: 

 

When Touch is using SSO, Unicode characters are not allowed in the domain user name and/or 
password. 

1. In DeltekTouch.I, set useExternalCredentials=true. By default, it is set to false. 

2. Copy KerberosSSOClientLib folder and KerberosSSOClient.jar file from the related TPU 
to cgi-bin/Maconomy. 

3. Make sure that Java is installed on the Maconomy Web server, since during Single Sign-
On, Deltek Touch executes Java code on the Maconomy Web server. This Java should 
be the same as the Java embedded in your Maconomy product (delivered as part of 
TPU); otherwise, there is a risk that newer Java versions are not certified for the 
Kerberos SSO used by Maconomy. 

4. Make sure there are is only one Java version installed on the machine 

5. Add the Java path to environment variables on the machine. 

6. In some cases you need to run some applications as administrator (for example, 
MaconomyMscript.exe, Run as Administrator). 

7. Deltek Touch uses the Kerberos Java client for getting the Kerberos ticket while other 
Maconomy clients (Workspace Client, Java Client, Portal) are using the native API for the 
same purpose. Therefore, even if SSO works properly in other Maconomy clients 
(Workspace Client, Java Client, Portal), there is no guaranty that it works in Deltek Touch 
as well. You may need additional steps for making the Touch SSO work.  

One possible difference is that, for Deltek Touch, the TSG request sent by the Maconomy 
Web server to the domain controller uses UDP instead of TCP. Since UDP is not as 
reliable as TCP, in case of bigger requests, this could lead to segmented packages, 
which may be dropped by the network. This leads to a situation when the request just 
hangs, the domain controller does not send back a response to the Maconomy Web 
server, and thereby causing an unsuccessful domain (SSO) login in Deltek Touch. If this 
is your case, you need to force the usage of TCP by creating a custom Kerberos 
configuration file (krb5.local.conf), as a copy of the standard Kerberos configuration file 
(krb5.conf) with one additional line: udp_preference_limit = 1. 

 

For example: 

 C:\maconomy\webserver\w_15_0.sp2\MaconomyMScript\Custom\DeltekTouch.I 

(useExternalCredentials=true) 

 Copy KerberosSSOClientLib folder and KerberosSSOClient.jar from 
C:\maconomy\tpu.NTx86.15_0.p2b6.dir\bin to 
C:\maconomy\webserver\w_15_0.sp2\cgi-bin\Maconomy 

  Install Java 7 

 Add C:\Program Files (x86)\Java\jre6\bin to Path in Environment Variables 

 

  



 

 

8. In some cases, the MaconomyTouch CGI program does not recognize the correct Java 
path. This can be enforced by setting the Java path explicitly in the CGI setup file. For 
example, change MaconomyTouch.test1.en_US.I as follows: 

// Scriptmode definitions Environment=Path=C:\Program Files 
(x86)\Java\jre\win32\x86\bin" 

Debug Deltek Touch Single Sing-On 

If you need to debug Deltek Touch Single Sign-On (SSO), complete the following steps: 

1. Make sure that SSO works in Java client and Portal. 

2. Check the Web server error logs (for example, C:\Program Files (x86)\Apache Software 
Foundation\Apache2.2\logs\error.txt). 

Deltek Touch with Load Balancing 

One of the questions raised, especially in a hosted (cloud) environments, is whether Deltek 
Touch supports load balancing. The answer is that it depends on your architecture and the 
purpose of the load balancing. 

The Touch Server supports load balancing. You can set up multiple Touch Servers behind a load 
balancer (for example, ELB or ALB). This allows you to route the requests from the Deltek Touch 
clients running on various mobile devices through multiple Touch Servers. 

The Touch Servers forward the requests to a Maconomy Web server. Deltek Touch, however 
does not support load balancing on this level in the sense that you cannot apply a load balancer 
using several Maconomy Web servers. The reason is that Deltek Touch does not support sticky 
sessions in the MScript Web service nor cookies in Deltek Touch. 

For each user, the MScript Web service uses a session, which is a physical file located on the 
Maconomy Web server. All requests from a user must reach the Maconomy Web server hosting 
the session file that corresponds to the user’s session. Therefore, in case you have a load 
balancer in front of the Maconomy Web servers (for example, for security reasons), you need to 
make sure all requests coming from the Touch Servers are routed to the same (one) Maconomy 
Web server. In case you have a setup wherein you use, for example, ELB/ALB for dynamic IP 
addresses, but you have one Maconomy Web server, this is supported if you disable the session 
IP validation (in the CGI setup .I file, set SessionIPCheck = 0). 



 

 

Appendix A: Localization 

Starting with Touch 1.2.3, you can translate Deltek Touch for Maconomy to other languages. 
Everything in Deltek Touch for Maconomy is translated using the dictionaries in Maconomy core 
product. 

By default, Deltek Touch for Maconomy 2.1,  2.2, and 2.3 come in the following languages: 

 English 

 Danish 

 Swedish 

 Norwegian 

 Dutch 

 French 

 German 

 Italian 

 Spanish 

 Portuguese 

Deltek Touch for Maconomy X1 and 2.0 come in the following languages: 

 English 

 Danish 

 Swedish 

 Norwegian 

 Dutch 

 French 

 German 

 Spanish 

 When you install FPU 1.2.3 - 2.1, you get the translations automatically through the standard 
dictionaries installed on the Maconomy server. After this, you need to set “(Re)install CGI 
programs” to “Install unconditionally”, in MConfig if you want to apply the dictionaries to the Web 
server, and thereby making the translations available in Deltek Touch for Maconomy. 

When you install Touch FPU 2.2 or later, it no longer contains Maconomy dictionaries. You need 
to install the latest translations FPU to get the dictionaries. 

If you need Deltek Touch for Maconomy in a different language, you need to create your own 
dictionary and apply it. 

 

For example, you would like to translate Deltek Touch for Maconomy to French. Assuming that 
you already have a French dictionary, you need to add the Touch translations to it: 

1. In Translations.<shortname>.DK search for “{Touch}”. This actions gives you the list of 

terms to be translated. 

2. You must translate all strings postfixed with {Touch} and add the translations to your 
French dictionary. For example, 

Yes{Touch} Oui 



 

 

Appenix B: Touch Server URL in Email 

Logging on for the first time no longer requires users to enter the complete URL of the Touch 
Server. You now send them an email message containing a link that either directs them to the 
appropriate app store (if Deltek Touch is not yet installed) or populates the Touch Server URL 
field with their company URL. 

ProductApplication.php 

The Touch Server has been updated with the ProdcuctApplication.php file that performs the 
linking and passes the Touch Server URL value to the application or redirects you to the 
appropriate app store.  

Link for Customers 

The link that you send to users is a hyperlink. When users click the hyperlink, the following 
scenarios occur: 

1. If Deltek Touch is not installed, it takes them to the appropriate app store to download the 
application. 

a. Users then download the application from the app store. 

b. They click the link again (and proceed to step 2). 

2. If the application is installed, it populates the Touch Server URL field with their company 
URL. 

3. They tap the Connect button to connect to the Touch Server. 

How to Create the Link to Email Users 

Each application may have specific steps required to create a hyperlink. This section describes 
the steps that apply to Microsoft Outlook. For other applications, see the documentation on 
creating a hyperlink. 

1. Use the following format for the hyperlink: 

https://<yourdomain 
>/deltektouch/maconomy/time/maconomyshared/backend/maconomytimeurl.php 

2. Replace <yourdomain> with the company’s domain information. The domain must be 
externally accessible to devices on the Internet. The following part of the hyperlink, 
however, is fixed:  

deltektouch/maconomy/time/maconomyshared/backend/maconomytimeurl.php 

If Deltek Touch is being hosted in a multitenant environment, you need to append a set of 
strings to the link you will be sending to users. Typically, it is the Web site directory name 
(for example, deltektouch).  For example, in the URL below, you should append 
“deltektouch”:  

https://<yourdomain>/deltektouch/maconomy/time/maconomyshared/backend/mac
onomytimeurl.php?custcd=deltektouch 

3. Create the instructional text in the email message where you will embed the link. 

4. Highlight the word “here,” right-click, and select Hyperlink from the menu (alternatively, 
click the Insert tab, and click the Hyperlink button).  



 

 

5. Paste the hyperlink into the Address field of the dialog box, and click OK. 

 

For Example: 

Click here to initialize your Touch application with the proper URL to access the Touch Server. If 
you have not installed the application, clicking the link will take you to the appropriate app store 
to install the application. Once you’ve installed the application, clicking the link will properly 
initialize the URL in your application. Should you not be able to click the link, you can copy and 
paste the following into your default device browser: 

https://yourdomain.com/deltektouch/maconomy/time/maconomyshared/backend/maconomytime
url.php 

When users receive the email, click the link , and the application is installed, the following screen 
displays. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://yourdomain.com/deltektouch/maconomy/time/maconomyshared/backend/maconomytimeurl.php
https://yourdomain.com/deltektouch/maconomy/time/maconomyshared/backend/maconomytimeurl.php


 

 

Appendix C: Logging Capability 

If you want to gather some statistics about your Deltek Touch users and their usage pattern, 
enable logging on the Maconomy MScript based Web service. 

 

Enabling logging always cause some performance overhead. If you use, however, the options 
recommended in this section, this overhead becomes unnoticeable. 

How to Enable Logging? 

To turn on logging, you need to change the setup file for the MaconomyTouch CGI program. 

To change the change the setup file, complete the following steps: 

1. In the Maconomy Web server, locate the /cgi-bin/Maconomy folder. 

2. Find the CGI program used by Deltek Touch by checking the URL in the configuration.ini 
file on the Touch Server. In most cases, the CGI program should be 
MaconomyTouch.*.exe. 

3. Find the setup file for the CGI program. If the CGI program is MaconomyTouch.*.exe, 
then the setup file is MaconomyTouch.*.I. 

4. Add the Log parameter. 

Where is the Log File? 

By default, the log file can be found in the same place as your CGI program and its setup file, 
which is in the /cgi-bin/Maconomy folder. 

The file name is the same as the CGI program name: MaconomyTouch.*.log. You can open the 
log file in any text editor. 

How to Determine Who are Using Deltek Touch? 

If you want to know who are using Deltek Touch and how often they use it, the recommended 
setting is as follows: 

Log = login 

As a result, the log file includes all Deltek Touch logins and the corresponding user names. 

Example 

[2015-11-25 11:48:28.171] [PID = 00018576] ) 

[/Standard/DeltekTouchWS.ms] [I286yaavF1] [3135] [192.168.43.102] 

[Administrator] maconomy::login("Administrator") (7 elapsed msec. 

[2015-11-25 11:49:15.749] [PID = 00002744] ) 

[/Standard/DeltekTouchWS.ms] [MNW33zWfr4] [32138] [192.168.43.102] 

[Administrator] maconomy::login("Administrator") (10 elapsed msec. 

[2015-11-25 11:54:59.823] [PID = 00018476] ) 

[/Standard/DeltekTouchWS.ms] [JDN9ASvjG2] [20598] [192.168.43.102] 

[Anders Hansen] maconomy::login("Anders Hansen") (19 elapsed msec.  

If you want the total number or none-unique logins, count the lines. You could conduct more 
elaborated analysis, by example, in Excel. 



 

 

If you want the total number or none-unique logins, count the lines. You could conduct more 
elaborated analysis, by example, in Excel. 

If you use Maconomy 2.2.6, 2.3.2 and 2.4 LA 2 or later, then this logging capabilitiy will allow you 
to track also users signing in using SSO, not only the users logging in to Touch with Maconomy 
credentials. 

How to Determine Which Deltek Touch Functionality is Used? 

This does not apply to RESTful Web services. 

If you want to know which Deltek Touch functionality is used, the recommended setting is as 
follows: 

Log = query 

This setting logs all requests coming from the Deltek Touch application. 

Example 

[2015-11-25 12:10:29.293] [PID = 00020192] [/Standard/DeltekTouchWS.ms] [192.168.43.102] 
Incoming query values: 

{ 

values:{ 

}, 

files:{ 

}, 

status:{ ok:true, message:"" 

}, 

method:"POST", 

rawPost:"{"inpObj":{"username":"Administrator","password":"123456","ope 

ration":"login","clean":false,"calfocus":false,"impersonate":false,"mac 

charset":"UTF-8","lang":"W","locale":"en_US"}}", 

raw:"{"inpObj":{"username":"Administrator","password":"123456","operati 

on":"login","clean":false,"calfocus":false,"impersonate":false,"macchar 

set":"UTF-8","lang":"W","locale":"en_US"}}" 

} 

[2015-11-25 12:11:19.098] [PID = 00018644] [/Standard/DeltekTouchWS.ms] 

[K1MW26xr68] [192.168.43.102] Incoming query values: 

{ 

values:{ 

}, 

files:{ 

}, 

status:{ ok:true, message:"" 

}, 

method:"POST", 

rawPost:"{"inpObj":{"theDate":"2015.11.25","startDate":"2015.11.23","en 

dDate":"2015.11.29","operation":"submittimesheet","clean":false,"calfoc 

us":false,"impersonate":false,"maccharset":"UTF- 

8","lang":"W","locale":"en_US","sessionid":"K1MW26xr68"}}", 
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raw:"{"inpObj":{"theDate":"2015.11.25","startDate":"2015.11.23","endDat 

e":"2015.11.29","operation":"submittimesheet","clean":false,"calfocus": 

false,"impersonate":false,"maccharset":"UTF- 

8","lang":"W","locale":"en_US","sessionid":"K1MW26xr68"}}&sessionid=K1M 

W26xr68" 

} 

Although this is more technical, if you search for the term “operation,” you can see what the user 
is trying to do. 

If you want to see how many time sheets have been submitted, search for 
"operation":"submittimesheet". 

 



 

 

Appendix D: Google Analytics  

If you want to gather some statistics about your Deltek Touch users and their usage pattern, 
another solution besides the logging is to use Google Analytics. 

Prerequisites: 

 You (as the customer) need to have a Google Analytics account 

 You (as the customer) need to make sure your end-users are accepting the Usage 
Tracking in the Deltek Touch application: 

 

 The Touch URL, for which you would like to get statistics, needs to be linked to your 
Google Analytics account. On the Touch Server, change the configuration.ini and set 
ANALYTICSKEY 

For example: ANALYTICSKEY="UA-704595989-5" 

You can now log on to your Google Account (https://analytics.google.com/analytics/web/). 

Using the built-in reports provided by Google Analytics, you can easily track the number of users, 
respectively new users, in a given period. 

https://analytics.google.com/analytics/web/


 

 

 

 

You can also track which screens (functionality) are used: 



 

 

 

 

 

For more advanced settings (like version numbers and login types), you should create your own  
custom reports. For this purpose, you need to add six custom dimensions, which must be in the 
order described below: 

1. Touch App Version: the native/web app version (e.g. 2.3.0) 

2. Touch Server Version: see below 

3. Web Service Version:  see below 

4. Web Service Type: "REST" or "MScript" 

5. Maconomy Version:  see below 

6. Touch Login Type: "Maconomy" or "Azure" or "Kerberos" 



 

 

 

 

 

You can then include the custom dimensions in your custom reports: 



 

 

 

 



 

 

Appendix E: If You Need Assistance 

If you need assistance installing, implementing, or using Deltek Touch for Maconomy, Deltek 
makes a wealth of information and expertise readily available to you. 

Customer Services 

For over 30 years, Deltek has maintained close relationships with client firms, helping with their 
problems, listening to their needs, and getting to know their individual business environments. A 
full range of customer services has grown out of this close contact, including the following: 

 Extensive self-support options through the Customer Care Connect Web portal. 

 Phone and email support from Customer Care analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and Web-based training 

 

Find out more about these and other services from the Customer Care Connect site. 

Customer Care Connect Site 

The Deltek Customer Care Connect site is a support Web site for Deltek customers who 
purchase an Ongoing Support Plan (OSP).  

The following are some of the many options that the Customer Care Connect site provides: 

 Search for product documentation, such as release notes, install guides, technical 
information, online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through 
the Deltek Connect Customer Forums 

 Access Cloud specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Use Quick Chat to submit a question to a Customer Care analyst online 

 

For more information regarding Deltek Customer Care Connect, refer to the online help available 
from the Web site. 



 

 

Access Customer Care Connect 

To access the Customer Care Connect site, complete the following steps:  

1. Go to http://support.deltek.com. 

2. Enter your Customer Care Connect Username and Password. 

3. Click Log In. 

 

If you do not have a username and password for the Customer Care Connect site, contact your 

firm’s Deltek Touch for Maconomy Administrator. 

If you forget your username or password, you can click the Account Assistance button on the 

login screen for help. 

Additional Documentation 

The following table lists the additional Deltek documentation available for this release. Except 
where noted, all the user guides and quick reference guides listed in this table are available for 
download from the Deltek Customer Care Connect site. 

Document Name Description 

Deltek Touch for Maconomy User Guide This document contains detailed information 
and instructions on how to use various 
features of the application. 

Deltek Touch for Maconomy Release Notes This document contains a summary of the 
technical considerations, major features, and 
known issues of the application. 

Deltek Touch for Maconomy Upgrade Guide This document is only intended for Technical 
Consultants. It describes necessary steps to 
upgrade to the latest Touch system. 

Deltek FPU Release Notes for Maconomy 
Touch 

These documents are only intended for 
Technical Consultants.  

The document names vary depending on the 
supported Maconomy version. Each document 
contains a summary of the pre-installation 
information, enhancements, and API changes 
to Touch for each supported Maconomy 
version. It is part of the Deltek Touch for 
Maconomy 1.4 product information suite and 
should only distributed internally within the 
Maconomy organization and to partners. 

Deltek Touch for Maconomy Layout 
Customization Guide 

This document is only intended for Technical 
Consultants. It describes tasks necessary for 
the customization of layouts of the Deltek 
Touch for Maconomy application. 

Deltek Touch for Maconomy MScript and 
REST Web Services Comparison Guide 

This document describes the differences 
between MScript and Representational State 
Transfer (REST) Web services to help 

http://support.deltek.com/


 

 

Document Name Description 

technical consultants prepare for implementing 
Deltek Touch for new users or migrate their 
current Touch installation to REST. 

 

 

 

Deltek is the leading global provider of enterprise software and information solutions for professional 
services firms, government contractors, and government agencies. For decades, we have delivered 
actionable insight that empowers our customers to unlock their business potential. Over 14,000 
organizations and 1.8 million users in approximately 80 countries around the world rely on Deltek to 
research and identify opportunities, win new business, optimize resource, streamline operations, and deliver 
more profitable projects. Deltek – Know more. Do more.P
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